Copyrights and Notices

Attachmate® Reflection® 2017

Copyright

© 2017 Attachmate Corporation, a Micro Focus company. All rights reserved.

No part of the documentation materials accompanying this Attachmate software product may be reproduced, transmitted, transcribed, or translated into any language, in any form by any means, without the written permission of Attachmate Corporation.

Patents

This Attachmate software is protected by U.S. patents 6252607 and 6803914. Additional Patent Pending.

Trademarks

Attachmate, the Attachmate logo, and Reflection are registered trademarks of Attachmate Corporation in the USA. All other trademarks, trade names, or company names referenced in this product are used for identification only and are the property of their respective owners.

Attachmate Corporation
705 5th Avenue South
Suite 1100
Seattle, WA 98104
USA
+1.206.217.7100
http://www.attachmate.com (http://www.attachmate.com)

Third-Party Notices

This product contains software from third party suppliers.

Specific notices

This software includes RSA BSAFE cryptographic or security protocol software from RSA. Copyright © 2008 RSA Security Inc. RSA Secured and the RSA Secured logo are registered trademark of RSA Security Inc.

This product uses the FreeType library.

Additional third-party copyrights and notices, including license texts and other materials passed through in compliance with third party license terms, can be found in a thirdpartynotices.txt file in the program installation folder.
1 Welcome to Reflection X Advantage

Welcome to Reflection X Advantage

Operating Modes: Domain vs. Standalone ................................................. 8
The X Window System ............................................................................ 9

2 Installation and Migration

System Requirements ............................................................................. 11
Install Reflection X Advantage on Windows ............................................ 11
Install on UNIX ...................................................................................... 12
Which Reflection X Advantage Features Should I install? ..................... 14
Upgrade and Migration .......................................................................... 15
  Upgrading from Earlier Versions of Reflection X Advantage ............... 16
  Upgrading from Reflection X version 13 or 14 ................................. 17
  Migrating Settings From Hummingbird Exceed ................................ 17
Optional Local Help File Installation ...................................................... 18
Uninstall Reflection X Advantage ........................................................... 18
  Remove the Reflection X Advantage Database Files ......................... 19

3 Getting Started

X Manager - Initial Startup ..................................................................... 21
X Manager for Domains - Initial Startup ................................................. 21
Launch an X Client Application Using the Sample Definitions .......... 22
Make an XDMCP Connection Using the Sample Definitions .............. 24
Sample Definitions ............................................................................... 25
The X Manager Interface ....................................................................... 26
Reflection X Icons .................................................................................. 27
Frequently Asked Questions .................................................................. 30

4 Remote Session Services in Standalone X Manager

X Manager Basic Session ......................................................................... 33
X Manager (Standalone) Distributed Session .......................................... 34
How to Configure a Distributed Session in Standalone Mode .............. 35

5 Domain Administration

Domain Administration ............................................................................ 37
Reflection X Advantage Domain Components ....................................... 37
Reflection X Advantage Session Processes .......................................... 38
X Manager for Domains Basic Session .................................................. 38
X Manager for Domains Distributed Session ........................................ 39
Setting up Domain Components ............................................................ 41
  Set Up the Domain Controller ........................................................... 41
  Start and Stop the Reflection X Service ............................................ 42
  Set Up an Administrator Workstation ............................................. 43
  Set Up Domain Nodes ....................................................................... 43
  Remove a Domain Node ................................................................... 44
  Set Up User Workstations ............................................................... 45
Manage Session Persistence and Performance .................................... 46
Domain Authentication ........................................................................... 47
  How Domain Access is Controlled ................................................... 47
Configure and Test User Authentication .............................................. 48
Set Up LDAP Authentication ............................................................... 49
Set Up Reflection X Advantage Internal Authentication ..................... 49
6 Customizing and Deploying Reflection X Advantage

Deploying Software - Overview .................................................. 61
Deploying Settings - Overview .................................................. 62
Using a Response File to Install on UNIX Systems ..................... 64
Deploying Sessions Using a Custom Template ............................ 66
Managing Installations on Windows Workstations ..................... 67
Performing a Basic Deployment ................................................. 68
Performing an Advanced Deployment ....................................... 68
Install from the Command Line ............................................... 69
Create an Administrative Installation Point ............................... 70
Installation Customization Tool .............................................. 71
Creating and Editing Transforms ............................................ 72
Creating and Editing Companion Installer Packages ................... 76
Deploying Sessions with the Administrative WebStation ............. 78
Configure Sessions using the Administrative WebStation ............. 79
Setting up a Session using the Security Proxy .......................... 79
Managing Upgrades for WebStation Sessions ........................... 81
Administrative WebStation Mode ............................................ 81
WebStation User Mode .......................................................... 81
Save Settings (Administrative WebStation Mode) ....................... 82
Discard Settings (WebStation User Mode) ................................. 82

7 Administrator Reference ....................................................... 83

Reflection X Advantage Data Files. ............................................ 83
Ports used by Reflection X Advantage ........................................ 85
Feature Guide for Upgrading from Reflection X version 13 or 14 .... 85
File Access Restrictions for Files With Sensitive Information ........ 88
Changing the JRE ................................................................. 90
Upgrade Digital Certificates used by Reflection X Advantage Domains .... 93
Command Line Utilities ......................................................... 93
 rxmgr Command Line - Standalone X Manager ........................... 93
 rxmgrdomains Command Line - X Manager for Domains .............. 95
 rxmigrate Command Line Utility - Migrate Settings .................... 98
 rxconfig Command Line Utility - Domain Configuration ............... 99
Using PKI Services Manager with Reflection X Advantage ............... 102
Setting up PKI Services Manager on Windows .......................... 103
Setting up PKI Services Manager on UNIX .............................. 106
Configure Reflection X Advantage to Connect to PKI Services Manager .... 109

8 Troubleshooting .................................................................... 111

Troubleshooting Tools ............................................................ 112
Log Files .................................................................................. 112
Create a Trace ......................................................................... 113
Application Fails to Start ....................................................... 114
Display Problems ..................................................................... 115
Connection Problems ............................................................ 116
Performance Problems ........................................................... 117
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Conflicts</td>
<td>117</td>
</tr>
<tr>
<td>Domain Logon Problems</td>
<td>117</td>
</tr>
<tr>
<td>Domain Node is Unavailable</td>
<td>118</td>
</tr>
<tr>
<td>IME Troubleshooting</td>
<td>118</td>
</tr>
<tr>
<td>Key Mapping Problems</td>
<td>119</td>
</tr>
</tbody>
</table>

**Glossary of Terms**  
121
Welcome to Reflection X Advantage

Reflection X Advantage is an X server that allows you to view your UNIX desktop and work with X client applications from a remote workstation. Reflection X Advantage provides two modes of operation—Standalone mode and Domain mode.

**Standalone mode** is provided by a single application—X Manager, which is installed by default. For users of earlier Reflection X products, Reflection X Advantage in standalone mode will be familiar territory: a bulletproof X server that provides reliable, seamless access to your mission-critical X applications.

**Domain mode** offers all the functionality of standalone mode and complements that power with additional features that help enhance productivity without increasing costs. Domain mode consists of multiple components—X Manager for Domains, the X Administrative Console, and the Reflection X Service. These features are not installed by default; and different systems within the domain require different components.

Whichever mode you choose, you’ll have access to the following features:

- **Multiple platform support**: Using Reflection X Advantage, users can access X hosts and applications from a broader-than-ever array of desktop environments, including Windows, Linux, Solaris, HP-UX, and AIX.

- **Real-time collaboration**: The session sharing features in Reflection X Advantage allow colleagues to look at the same applications concurrently, and even transfer control of the session from one user to another.

- **Improved performance options**: Using Reflection X Advantage, you can address problems with low bandwidth or high latency connections using remote session services. When you configure distributed Reflection X Advantage sessions, only the protocol required to update the display is sent over the network. This results in dramatically improved performance where high latency is a problem. Where low bandwidth is a problem, Reflection X Advantage automatically compresses the protocol sent to remote X servers.

- **Fully-integrated Secure Shell with FIPS 140-2 validation support**: With Reflection X Advantage, you get a single-vendor security solution that is integrated with the X server.

- **X11 Extension Support**: Reflection X Advantage provides support for key X11 extensions including GLX, Render, Damage, Shape, and XFixes.

- **Native IME support for input of double-byte characters**: Native IME support lets you use your workstation’s input method editor (IME) to compose characters (including Japanese, Korean, and Chinese). The X11 Input Method (XIM) server provided by Reflection X Advantage obtains the composed text from your IME and passes it to XIM-aware clients. This means that you can work with varied X clients without having to learn new input techniques.

- **X.509 certificate authentication**: Secure Shell connections require both user and host authentication. In addition to supporting standard options for user authentication (passwords and public keys), Reflection X Advantage also supports authentication using X.509 certificates. Certificates can be stored in the Reflection X Advantage Store, a local directory, the Windows Certificate Store, or on a Smart card or similar device. Also, by downloading and installing Reflection PKI Services Manager, you can configure Reflection X Advantage to authenticate hosts that present X.509 certificates. Reflection PKI Services Manager is available at no additional charge.
Additional features available in Domain mode include:

- **Centralized session configuration:** Reflection X Advantage domain features can help simplify session setup for end users. Administrators can create and maintain client and session definitions in a single centralized location and provide users with access to these definitions. Users can get started quickly using these centrally configured sessions, and can also create and configure individual sessions on their own workstations.

- **Flexible, instant access to an established session from the office, at home, or on the road:** Leave a running session from one location and rejoin the same session from another location. No time is spent on reestablishing the client connection.

- **Session protection:** When you run a distributed session, you can use fault tolerance to safeguard against losing the session. This option enables you to return to your work exactly where you left it, even after a network or hardware failure.

- **Domain authentication services:** Leverage your current authentication process to provide Reflection X Advantage domain authentication. Use any of these authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Internal.

- **Load balancing:** In a distributed session environment, Reflection X Advantage is installed on more than one computer, and sessions can run on multiple domain nodes. When a user initiates a session, the session is run on the least-loaded domain node.

### Operating Modes: Domain vs. Standalone

Reflection X Advantage can be operated in either "Standalone" or "Domain" mode.

**Standalone mode**

Standalone mode is provided by a single application—X Manager, which is installed by default. In this mode you use one application, X Manager to access X hosts and clients, configure and share sessions, and monitor session status — all from your own desktop. For a quick introduction to client and session configuration, see "Getting Started" on page 21.

**Domain mode**

Running Reflection X Advantage in Domain mode provides access to all the features in standalone mode, and also provides access to additional domain services. Domain administrators run the **X Administrative Console** to configure and manage Reflection X domains, and to handle load balancing, optimizing performance for a group of X sessions. Domain users run **X Manager for Domains** to access X hosts and clients. These applications connect to a central domain controller, which runs the Reflection X service and stores session definitions in a shared database. As an authorized domain user, you can start, join, leave, and share a running X session. You can use all public definitions created by administrators, as well as create private definitions available only to you. For information on setting up and configuring a Reflection X Advantage domain, see **Reflection X Advantage Domain Administration (page 37).**

**Feature comparison**

<table>
<thead>
<tr>
<th>Launch and interact with an X client application</th>
<th>Standalone Mode (X Manager)</th>
<th>Domain Mode (X Manager for Domains)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>


The X Window System

The X Window System is a portable, multi-user graphical window system originally developed at MIT. “Portable” means that it can run on many types of host computers (including OpenVMS and a variety of Linux and UNIX hosts). “Multi-user” means that many users can have simultaneous access to X applications by connecting to the host over a network. As a window system, X allows users to run several applications at one time, each in its own window (similar to Microsoft Windows).

X applications (clients) provide the graphical user interface for many host-based environments — a few well-known environments are the GNOME Desktop Environment (GDE), the K Desktop Environment (KDE), and the Common Desktop Environment (CDE). X applications are also commonly developed for engineering, scientific, and manufacturing purposes.

The X Window System is based on a client/server model:

- The X "client" is an application program that runs on a host computer.
- The X display "server" is the intermediary software between the client application programs and the local display hardware and input devices (mouse and keyboard). The server tracks all input from these devices and conveys it to the relevant client applications.
  
  The server also responds to client requests for output, and updates the display to reflect the output. In Reflection X Advantage the display and the X server have been decoupled.

This division in the X Window System architecture allows the clients and the display server to reside on different types of computers. The client applications reside on UNIX hosts while the server runs on the local computer. With Reflection X Advantage this can be a Windows or UNIX computer.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standalone Mode (X Manager)</th>
<th>Domain Mode (X Manager for Domains)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XDMCP</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>X session sharing</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>X11 Extensions support</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Improved performance over slow networks</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Integrated Secure Shell</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>FIPS 140-2 support</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>X.509 certificate authentication</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Native IME support</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Centralized configuration of settings</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Leave and rejoin X sessions</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Fault tolerance for X sessions</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Domain authentication services</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Load balancing</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
Because the X display server runs on a local computer, client/server terminology often seems reversed to people new to the X Window System. As a display server, the local computer provides the services of the local display, keyboard, and mouse to applications (clients) running on other computers.

**Requests, Replies, Events, and Errors**

The X server and X client applications communicate by the following means:

- Requests from clients to the server.
- Replies from the server to clients, in response to client requests.
- Events to be delivered to any clients that have registered to receive events.

An event occurs when there is user input (the mouse is moved, or a key is pressed), or other information sent from the display server to the client application. After a client application receives a meaningful event, it may respond with more requests to the server for some sort of action affecting the display.

- Errors to be delivered to clients when a request fails, or is invalid.
2 Installation and Migration

Reflection X Advantage can be installed on Windows or UNIX systems. On Windows systems, it is installed as part of suite products which install Reflection X Advantage with additional applications. The UNIX installers install just Reflection X Advantage. In a distributed environment, you can install on either or both operating systems.

- “System Requirements” on page 11
- “Install Reflection X Advantage on Windows” on page 11
- “Install on UNIX” on page 13
- “Which Reflection X Advantage Features Should I install?” on page 14
- “Upgrade and Migration” on page 15
- “Optional Local Help File Installation” on page 18
- “Uninstall Reflection X Advantage” on page 18

System Requirements

System requirements information is available from the Micro Focus Technical Library.

- For information about supported platforms and additional system requirements, see Technical Note 2833 (http://support.attachmate.com/techdocs/2833.html).
- For updates about security issues related to Reflection X Advantage, see Technical Note 2505 (http://support.attachmate.com/techdocs/2505.html).

Install Reflection X Advantage on Windows

Reflection X Advantage is included as a component in Reflection X Desktop and Reflection Pro Desktop.

The following applications are installed by default:

- X Manager
  Provides complete support for connecting to X clients in standalone mode.
- Reflection Workspace
  Provides access to VT terminal sessions. With Reflection Pro Desktop, IBM terminal and printer support is also included.
- Reflection FTP Client
  Supports file transfer using both FTP and SFTP protocols.

A 64-bit installer is available for installing Reflection X Desktop and Reflection Pro Desktop on 64-bit Windows platforms. This installer includes 64-bit Reflection X Advantage and 32-bit Reflection Workspace and Reflection FTP client. (The 32-bit applications are supported on 64-bit platforms.) Legacy Reflection X is not included with the 64-bit installer.
If you are planning on running Reflection X Advantage in domain mode, you will need to install additional features on the computers running in your domain. These features are not installed by default. For a summary of some typical installation configurations for domain mode, see “Which Reflection X Advantage Features Should I install?” on page 14 For more detailed information, see “Setting up Domain Components” on page 41.

To install on Windows

1. Log on using a Windows account with administrator privileges.
2. Start the Setup program (Setup.exe). If you are installing from the download site, the following steps start this program:
   2a. From the download site, click the Windows download link and run the download program.
   2b. Select a location for the installer files, and then click Next. This extracts the files to the specified location and starts the Setup program.
3. The installer checks your system for required software prerequisites. If these are not present, the installer installs these packages before running the product installation.
4. To view and/or modify which features are installed, click the Feature Selection tab.

**Installation Log File**

An installation log file is created by default, but this file is deleted if the installation succeeds. If your installation does not succeed, you can use the log file to troubleshoot. The log file is saved to your temp directory with a generated name that begins with atm. To open this folder, enter %tmp% in the Start menu's "Search programs and files" text box or in the path box of a Windows Explorer window.

**Associated Installers**

When you install Reflection X Advantage on Windows, some features are installed using associated installers that run automatically as needed.

**NOTE:** If you install from a command line using setup.exe, prerequisite packages are installed automatically. If you install using msiexec.exe, prerequisite packages are *not* installed automatically. For details, see "Install from the Command Line" on page 69.

**Java JRE Installation**

All Reflection X Advantage features require Java, and the Java Runtime Environment (JRE) feature is selected by default. When this feature is selected, the associated installer installs a JRE that is correctly configured to fully support all Reflection X Advantage features. Micro Focus will supply updated Java installation packages as needed to provide customers with Java security updates. These packages can be downloaded and applied independently of any updates you apply to the main installer package. The JRE installed with Reflection X Advantage is uninstalled automatically when you uninstall Reflection X Advantage.

It is also possible to configure Reflection X Advantage to use a different JRE. For details about how to configure a non-default JRE, see “Changing the JRE” on page 90.

**NOTE:** The Micro Focus Java installer adds a separate entry in the Windows Programs and Features Control Panel. Uninstalling the Reflection program automatically uninstalls the Micro Focus Java entry if it is no longer being used by any application. If you uninstall using an msiexec command line, you need to uninstall the Java program as a separate step.
Microsoft .NET 4.5.1 Installation

All Reflection Workspace features require Microsoft .NET 4.5.1 to be installed on your system. If it is not on your system and you install Reflection X Desktop or Reflection Pro Desktop using the defaults (or include any Reflection Workspace features), Microsoft .NET Framework Setup program is installed and started after the Reflection X Advantage installation completes. You must accept the Microsoft license agreement to complete this installation.

Microsoft .NET is a shared component and is not uninstalled when you uninstall Reflection. To uninstall Microsoft .NET, use the Windows Programs and Features Control Panel and uninstall each of the Microsoft .NET Framework 4 items.

If you are an administrator, you can use “Installation Customization Tool” on page 71 to configure a silent install that includes the Microsoft .NET installation without displaying the Microsoft .NET Setup user interface. If you create a transform that sets the user interface level to None, the Microsoft .NET Setup user interface is not displayed. If the user interface level is either Basic or Full, the Microsoft .NET setup user interface is displayed.

Visual Basic for Applications Installation

The Visual Basic for Applications feature is available with the Reflection Workspace emulators. Installations that include this feature install Microsoft VBA 7.1. Visual Basic for Applications is a shared component and is not uninstalled when you uninstall Reflection X Advantage.

Install on UNIX

Use this procedure below to install Reflection X Advantage on UNIX or Linux systems.

X Manager is installed by default. This application provides complete support for connecting to X clients in standalone mode. If you are planning on running Reflection X Advantage in domain mode, you will need to install additional features on the computers running in your domain. These features are not installed by default. For a summary of some typical installation configurations for domain mode, see “Which Reflection X Advantage Features Should I install?” on page 14 For more detailed information, see “Setting up Domain Components” on page 41.

NOTE: UNIX installers do not include the emulators and FTP Client, which are only available when you install on Windows.

To install Reflection X Advantage on UNIX systems

1 Download the installation package for your UNIX operating system from the download site.

   NOTE: The download files (*.zip) for each supported UNIX system include both 32-bit and 64-bit installers if both platforms are available.

2 Unzip the download file; for example:

   unzip -d rx-advantage-16.1.0.999-prod-linux.zip

   The expanded download file contains binary files (*.bin) for installing on different platforms. Locate the appropriate file for your UNIX platform. The product installation package name begins with "rxa-5.n.n.nnn."

   The package name that begins with "rxa_help-5.n.n.nnn installs local help files. Installing these files is optional. By default, Reflection X Advantage uses product Help located on the website. For more information, see “Optional Local Help File Installation” on page 18.
3 If you unzipped on a Windows computer, copy the installation file for your platform to your UNIX computer.

4 Log on as root and navigate to the directory that contains the installation file.

5 Change the permissions of the installation package to give execute permissions to the file owner. For example:

   chmod 744 rxa-16.1.0.999-prod-x86_84-linux.bin

6 Start the installation program. For example:

   ./rxa-16.1.0.999-prod-x86_84-linux.bin

   **NOTE:** The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line installation, you can add the parameters `-i console`. For example:

   ./rxa-16.1.0.999-prod-x86_84-linux.bin -i console

7 You can modify the feature selections during the install. X Manager is installed by default.

   **NOTE:** If you are using the `-i console` option, you'll have an opportunity to specify which features you want to install by entering a comma-separated list in response to the prompt: "Please choose the Features to be installed by this installer:" To install all features, you can type 1,1. For additional command line options, see Using a Response File to Install on UNIX Workstations (page 64).

**Installation Log File**

On UNIX systems, an install log is created here: `/opt/rxadvantage/<product_name>_InstallLog.log`.

**Which Reflection X Advantage Features Should I install?**

X Manager (standalone) is installed by default. If you plan on configuring a Reflection X Advantage domain, you need to install additional features. The following tables summarize some typical installation configurations.

- You can install and use any combination of Reflection X Advantage features on a single computer. The following table provides guidelines, but you are not limited to these configurations. For example, you may want to install and run both X Manager (standalone) and X Manager for Domains on the same computer.

- A Java Runtime Environment (JRE) is required for all Reflection X Advantage applications and services. On UNIX systems this is always included as part of the installation. On Windows systems the JRE is listed as a separate feature in the installer. Include this feature with all installations unless you have installed and configured an alternate JRE (page 90).

- The Template feature provides sample settings to help you get started. This feature is not required, but is recommended unless your administrator has customized your installation to provide custom settings for your environment.
Review these guidelines if you are planning to run in domain mode (page 37).

**Domain mode**

<table>
<thead>
<tr>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Manager for Domains</td>
</tr>
<tr>
<td>Templates</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) (on Windows)</td>
</tr>
<tr>
<td>X Manager for Domains</td>
</tr>
<tr>
<td>X Administrative Console</td>
</tr>
<tr>
<td>Templates</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) (on Windows)</td>
</tr>
<tr>
<td>X Administrative Console</td>
</tr>
<tr>
<td>Domain Services</td>
</tr>
<tr>
<td>Domain Controller</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) (on Windows)</td>
</tr>
<tr>
<td>Domain Services (without the domain controller)</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) (on Windows)</td>
</tr>
</tbody>
</table>

**Related Topics**

- “Remote Session Services in Standalone X Manager” on page 33
- “Domain Administration” on page 37
- “Associated Installers” on page 12

**Upgrade and Migration**

**In this Section**

- “Upgrading from Earlier Versions of Reflection X Advantage” on page 16
- “Upgrading from Reflection X version 13 or 14” on page 17
- “Migrating Settings From Hummingbird Exceed” on page 17
Upgrading from Earlier Versions of Reflection X Advantage

If you are upgrading from an earlier version of Reflection X Advantage (or any product that includes Reflection X Advantage as a feature), note the following:

- You can run the new installer with an installed version in place. The earlier version is uninstalled as part of the installation process. Your existing settings are retained and used automatically after the upgrade. Your database files are migrated automatically to the current version the first time Reflection X Advantage is started. Start Menu shortcuts are moved to a new **Micro Focus Reflection** folder.

- Reflection X Advantage stores user data (including database files for the standalone X Manager and user log files) in a different location than that used prior to version 5.1. The data location used for the domain database has not changed.
  - If you install without uninstalling your prior version, Reflection X Advantage continues to use your existing data files in their original location.
  - If you uninstall an earlier version (prior to 5.1) before installing, the new installation uses new default settings in the new location. In this case, you can manually copy your customized data to the new location.

For details see **Reflection X Advantage Data Files (page 83)**.

- If you use the **Remote Session Services** feature to configure distributed sessions with the standalone X Manager, you must upgrade all components at the same time. This feature does not support mixed versions.

- If you distribute sessions using the **Reflection Administrative WebStation (page 78)**, review the information in **Managing Upgrades for WebStation Sessions. (page 81)**

Upgrading Reflection X Advantage Domains

If you are upgrading from version 5.0 or later, you can upgrade domain components in stages:

1. Upgrade all systems running X Manager for Domains and the X Administrative Console before you upgrade the domain controller. These components are backward compatible, not forward compatible.

   These components will be able to connect to your (older) domain controller and will run using the version that is running on that domain controller. This means that features or bug fixes in the newer version will not yet be available.

2. Upgrade your domain controller and any configured domain nodes after all other computers in the domain have been upgraded.

   After the domain controller is upgraded, all domain components will run using the newer version; at this time the latest features and bug fixes become available to the upgraded systems running X Manager for Domains and the X Administrative Console.

What Reflection X Advantage version am I running?

For version information, go to **Help > About X Manager.** The information displayed always shows the currently installed version. If you are connected to an older domain controller, the display also shows the current running version. On Windows, Reflection X Advantage is installed as a feature in Reflection Desktop installers, and this information is also included.
Upgrading from Reflection X version 13 or 14

The first time you start Reflection X Advantage (either X Manager or X Manager for Domains), local settings from Reflection X version 13 or 14 are migrated automatically and saved to a Reflection X Advantage “definition file” on page 121. On this first start-up, the Import Migrated Settings and Templates dialog box opens and includes an option to import your migrated settings. This option is selected by default. Click Import to add these settings to Reflection X Advantage. Your existing Reflection X settings are not changed.

- To launch an X client or XDMCP connection, double-click the client name. Or, select a client, then click the start button:

You prior version server settings are migrated to a session definition named “config,” which is configured to start automatically when you start X Manager. If you created any additional X Server instances, these settings are migrated using the name you provided.

See “Feature Guide for Upgrading from Reflection X version 13 or 14” on page 85 for help finding features in Reflection X Advantage.

The Import Migrated Settings and Templates dialog box displays only once, but it is possible to manually import migrated settings later if you do not import them on initial startup.

You can also migrate settings manually using the rxmigrate (page 98) command line utility. This is useful if you have configured settings in a shared network location; these settings are not migrated automatically.

Migrating Settings From Hummingbird Exceed

The first time that you start Reflection X Advantage (either X Manager or X Manager for Domains), local settings from Hummingbird Exceed products (versions 9.0 and higher) are migrated automatically and saved to a Reflection X Advantage “definition file” on page 121. On this first start-up, the Import Migrated Settings and Templates dialog box opens and includes an option to import your migrated settings. This option is selected by default. Click Import to add these settings to Reflection X Advantage. Your existing Hummingbird files are not changed.

- To launch an X client or XDMCP connection, double-click the client name. Or, select a client, then click the start button:

The Import Migrated Settings and Templates dialog box displays only once, but it is possible to manually import migrated settings later if you do not import them on initial startup.

You can also migrate settings manually using the rxmigrate (page 98) command line utility. This is useful if you have configured settings in a shared network location; these settings are not migrated automatically.
Optional Local Help File Installation

By default, Reflection X Advantage opens product help from the web. If you prefer to use locally installed help files on Windows systems, you need to run a separate Help installer after you install the product installation.

- For Windows systems, you will need to download the Help installer from the product download site. Select either the 32-bit or 64-bit installer to match the option you used for your product installation.
- For UNIX systems, the Help installation package is included with the product download for your UNIX operating system.

After you install the local help files, you need to configure each installed Reflection X Advantage application to use the installed help system.

- Go to File > Preferences in X Manager, X Manager for Domains, or X Administrative Console to configure your help preference for that application.

If the help system you specify is not available, Reflection X Advantage will automatically attempt to use the other option.

Uninstall Reflection X Advantage

**NOTE:** These procedures uninstall the Reflection X Advantage application. Reflection X Advantage databases, which contain your configuration information, are not removed.

To uninstall on Windows

1. Log on as an administrator.
2. From the Windows Control Panel, open Programs and Features (or Windows Add or Remove Programs, depending on your version of Windows.)
3. Select Micro Focus Reflection X Advantage, click Uninstall (or Remove).

To uninstall on UNIX

1. Log on as root.
2. Open a terminal window and navigate to the Uninstall_rxadvantage directory, which is located in the Reflection X Advantage installation directory. The default location is:
   
   /opt/rxadvantage/Uninstall_rxadvantage

3. Enter the following command to initiate the uninstall and follow the uninstaller instructions.

   ./Uninstall_rxadvantage

**NOTE:** The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line uninstall, you can add the parameters -i console as shown here:

   ./Uninstall_rxadvantage -i console
Remove the Reflection X Advantage Database Files

Uninstalling Reflection X Advantage does not remove your configured database. Use these procedures to remove the database files.

To remove database files from a Windows installation

1. To remove the database used by X Manager for Domains, navigate to the %ALLUSERSPROFILE% folder (typically C:\ProgramData) and remove the .attachmate folder and all of its subfolders.

2. To remove the database used by the standalone X Manager, navigate to one of the following locations and remove the db folder and all of its subfolders.

   - If you installed a current version, the database is in the Personal Documents folder under Micro Focus\Reflection.
   - If you upgraded from a version prior to 5.1, the database is in the User Profile folder under \attachmate\rx\.

To remove files from a UNIX installation

1. Delete the installation directory. The default location is:

   /opt/rxadvantage

   For example, navigate to the opt folder and enter:

   rm -fr rxadvantage

   The db and logs subdirectories of the installation directory contain the database and logs used by X Manager for Domains.

2. Navigate to the home directory of any user who has configured X Manager and remove the .microfocus (or .attachmate) directory and all of its subdirectories. For example:

   rm -fr .microfocus

   This directory contains the database and logs used by X Manager.
X Manager - Initial Startup

This procedure describes what you see the first time you run the standalone X Manager. See “X Manager for Domains - Initial Startup” on page 21 if you run in domain mode.

Before you begin

- Install Reflection X Advantage using defaults. (This includes the X Manager and Templates features).

To start X Manager and import templates and migrated settings

1. Start X Manager. (On Windows, go to Start > All Programs > Micro Focus Reflection > X Manager.)

   The first time you run X Manager, the Import Migrated Settings and Templates dialog box opens. This dialog box includes a list of sample connection settings for different host types. Migrated settings are also listed if you are running on a system with local settings used by earlier Reflection X products (typically version 13 or 14), or Hummingbird Exceed. (This dialog box does not open if you are upgrading from an earlier version of Reflection X Advantage.

2. Do one of the following:
   - Select the settings you want to import and click Import. This imports the selected settings plus a set of default sample definitions.
   - Click Cancel. When you cancel, Reflection X Advantage does not import any of the listed settings, but does import the default sample definitions.

X Manager for Domains - Initial Startup

Use this procedure to get started with X Manager for Domains running on a Windows system. See “X Manager - Initial Startup” on page 21 if you run in standalone mode (which is the default).
NOTE: This procedure assumes that a Reflection X Advantage domain has already been setup by an administrator. For information about setting up a domain, see Reflection X Advantage Domain Administration (page 37).

Before you begin

- Obtain your Reflection X Advantage domain name and logon credentials from your administrator. (In most cases your username and password are the same as those you use to log onto the system running X Manager for Domains.)
- Install X Manager for Domains. (This is not installed by default when you install Reflection X Advantage.)

To start X Manager for Domains and import templates and migrated settings

1. Start X Manager for Domains. (On Windows, go to Start > All Programs > Micro Focus Reflection > X Manager for Domains.)
2. In the domain logon dialog box:
   - For User name and Password, enter your logon credentials (either the username and password you use to start your system, or the credentials provided by the Reflection X Advantage administrator.)
   - For Domain, enter the domain name you received from your administrator. (After your first successful logon, this name is entered automatically for you.)
3. Depending on how your domain is configured, you may see the Import Migrated Settings and Templates dialog box. If you see this dialog box, you can use it to select optional sample settings for import. Do one of the following:
   - Select the settings you want to import and click Import. This imports the selected settings plus any available default definitions.
   - Click Cancel. When you cancel, Reflection X Advantage does not import any of the listed settings, but does import the default definitions.

When X Manager for Domains opens, the list of settings available under My Definitions may include any of the following:

- Default definitions that were imported automatically.
- Custom definitions that were imported automatically. (These can be configured in templates created by an administrator and added to a customized installer.)
- Connection settings and migrated definitions that you selected in the Import Migrated Settings and Templates dialog box.
- Public definitions that have been created and shared by your administrator. These definitions are read-only and are identified with a different icon (page 27).

Launch an X Client Application Using the Sample Definitions

Reflection X Advantage installs several "Sample Definitions" on page 25 by default. In many cases you can get connected without making any changes to these sample settings. You can then use the samples as a model for making additional connections.

To connect using a sample X client definition

1. Start X Manager or X Manager for Domains.
2 Under X Clients on the left, select one of the sample definitions. You can use the generic "xterm" definition. Or, if you imported templates for your host type, select one of these (such as "Linux - xterm" or "VMS - DECterm"). Connect using any of these methods:

- Double-click the definition name.
- Select the definition, then in the toolbar click Start.
- Right-click the definition name and click Start.

3 Enter your host and user name in reply to the prompt.

If the host is available and supports Secure Shell connections, you see the Host Key Unknown message the first time you connect. Click Always to trust the host key. Reflection X Advantage saves this key and uses it in subsequent connections to confirm that you're connecting to the correct host.

4 Enter your password in response to the prompt.

If your connection is successful, a window opens on your desktop showing your host command prompt.

You can clone the sample client definition to create a duplicate copy. By cloning a definition, you create a new definition with the same settings and preserve the original definition to use as a reference. To clone a definition:

- Right-click the client definition and select Clone Client.

You can edit the cloned definition. Changes are saved automatically as you work. For example:

- Enter values for Host name and User name.
- Change the value of Host type. This changes the list of sample commands available to you.
- Edit the Command to start a different X client application. Use the drop-down arrow to view sample commands that typically work for the host type you selected.

Troubleshooting

If you don't see sample definitions listed under X Clients:

- When you upgrade from a previous version of Reflection X Advantage, no changes are made to your existing settings. This means that after an upgrade, the sample definitions are not imported, even if the correct template is installed. You can use the File > Import command to manually import templates. Look for installed templates in the templates subfolder in the installation folder, typically:

  C:\Program Files\Micro Focus\Reflection\templates

If you're unable to make a connection using one of the sample definitions:

- Look at the status bar at the bottom of the X Manager window for information. For additional information about each error, click the information button, 🔍.
- Error messages remain in the status bar. Click the delete button, 🗑, to clear messages between tests.

Here are a few common errors.
Make an XDMCP Connection Using the Sample Definitions

Reflection X Advantage installs several "Sample Definitions" on page 25 by default. In many cases you can get connected without making any changes to these sample settings, then use the sample as a model for making additional connections. This procedure makes an XDMCP connection using the sample 'Direct connection' definition.

NOTE: XDMCP must be enabled on your UNIX host.

To connect using the sample XDMCP connection

1. Start X Manager or X Manager for Domains.
2. Under XDMCP Connections on the left, locate the sample definition called "Direct connection" and connect using any of these methods:
   - Double-click the definition name.
   - Select the definition, then in the toolbar click .
   - Right-click the definition name and click Start
3. Enter your host name in reply to the prompt.
   If the connection is successful, an X terminal desktop window opens showing your host login screen.
4. Enter your login credentials for the host.

You can clone the sample "Direct connection" XDMCP definition to create a duplicate copy. By cloning a definition, you create a new definition with the same settings and preserve the original definition to use as a reference. To clone the definition:

   - Right-click the client definition and select Clone XDMCP connection.
You can edit the cloned definition. Changes are saved automatically as you work. For example:

- Use Name to specify a descriptive name for your connection.
- Enter a value for Host name to connect to the same host each time. Or, change Type to Broadcast to see a list of available hosts based on a broadcast sent to the address (or addresses) you configure.

Troubleshooting

If “Direct connection” isn't listed under XDMCP Connections:

- When you upgrade from a previous version of Reflection X Advantage, no changes are made to your existing settings. This means that after an upgrade, the sample definitions are not imported, even if the correct template is installed. You can use the File > Import command to manually import the template called generic_templates.rxd.

If you're unable to make a connection using the “Direct connection” definition:

- If you see a message saying Unknown host: <hostname>, the host name you specified isn't reachable. Check your entry or try specifying a host IP address instead of using the host name.
- If the X terminal desktop window opens and is followed by an XDMCP timeout message, XDMCP may not be configured on the host. On some networks, you can see a list of hosts that support XDMCP by changing Type to Broadcast. Or, try configuring a desktop connection using an X Client command rather than using XDMCP.

Sample Definitions

The sample definitions described below are imported automatically the first time you start X Manager or X Manager for Domains. In addition to these default definitions, you may see additional samples if you imported templates when you first started X Manager or X Manager for Domains.

<table>
<thead>
<tr>
<th>Definition Name</th>
<th>Description</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>xterm</td>
<td>Prompts you for host and user information, and sends an xterm command to this host. If the command is successful, you see a terminal session on your desktop.</td>
<td>This client starts the &quot;My desktop&quot; session. The sample command requires the xterm command to be in the path on your host. If this command fails, try changing the Host type to match your system, then select xterm from the Command drop-down list.</td>
</tr>
<tr>
<td>Direct connection</td>
<td>Prompts you for a host name and starts an XDMCP connection to this host.</td>
<td>This client automatically starts the &quot;X terminal desktop&quot; session. XDMCP must be enabled on the host. Try changing Type to Broadcast. In some networks, this displays a list of hosts available for XDMCP connections.</td>
</tr>
<tr>
<td>X terminal desktop</td>
<td>Starts an X server configured to display clients within an X terminal window on your desktop.</td>
<td>This session uses all default settings. Use this session for XDMCP connections and X client definitions that launch a desktop environment (such as KDE, CDE or GNOME).</td>
</tr>
<tr>
<td>My desktop</td>
<td>Starts an X server configured to display clients in separate windows on your desktop.</td>
<td>This session enables Show clients on my desktop. All other settings use defaults.</td>
</tr>
</tbody>
</table>
In some cases you may not see these definitions:

- The definitions listed above are imported automatically from a generic settings template (generic_templates.rxd), which is installed by default. If this template isn't installed, you won't see these settings.
- If you upgraded from a previous version of Reflection X Advantage, no changes are made to your existing settings. This means that after an upgrade, these definitions are not imported even if the correct template is installed. You can use File > Import to manually import the template called generic_templates.rxd. This template is located in a folder called templates in your product installation folder.
- Administrators can customize the installed templates. If your administrator has customized your installation, you may see different default definitions.

The X Manager Interface

The X Manager interface includes a navigation pane on the left, and a definition pane on the right.

Navigation pane

As you work with the navigation pane, you can:

- Click a definition to view and/or modify its settings in the definition pane on the right.
- Right-click a definition to display a menu of available actions.
- Select a definition and move it using the up and down arrow icons next to the section title.
- Drag and drop a definition to move it within a section.
- Drag an X client or XDMCP definition onto a session definition to start it with that session.
- Drag an X client or XDMCP definition onto a launch group definition to add it to that launch group.
- Sort definitions in a section alphabetically using the sort icon.
- Show and hide sections using the expand and contract icons.
- Hide sections, or change the order in which they appear, using File > Preferences > Section Visibility.
As you work in the definition pane, note the following:

- As you make edits, observe that there are no OK or Apply buttons — your changes are automatically saved.
- You can edit the sample definitions and any additional definitions you have created. If you are running X Manager for Domains, you may also see public definitions created by an administrator and shared to domain users. You cannot edit these definitions.
- Running sessions appear under the session definition. Click on a running session to view session status information in the definition pane.
- Changes you make to a session definition while a session is running do not take effect until the session is stopped and restarted.
- Hover over a setting to view a tooltip with information about that setting. For additional information about the current definition pane, click the help icon.

### Reflection X Icons

The icons displayed in the left panel of X Manager show the status of the X Manager components available to you.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Create</td>
</tr>
<tr>
<td>Delete</td>
<td>Create a new definition.</td>
</tr>
<tr>
<td>-</td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td>Delete the currently selected definition</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>🔄</td>
<td>Move up</td>
</tr>
<tr>
<td>🔄</td>
<td>Move down</td>
</tr>
<tr>
<td>🔄</td>
<td>Sort alphabetically</td>
</tr>
<tr>
<td>🔄</td>
<td>Hide</td>
</tr>
<tr>
<td>🔄</td>
<td>Expand</td>
</tr>
</tbody>
</table>

**X client definition**
Configuration settings for starting an X client application.

**Public X client definition**
(domain mode only) X client definition created by the administrator, and available to all users in the domain. Only the administrator can modify the settings in this shared definition.

**XDMCP definition**
Configuration settings for making an XDMCP connection.

**Public XDMCP definition**
(domain mode only) XDMCP connection definition created by the administrator, and available to all users in the domain. Only the administrator can modify the settings in this shared definition.

**Launch group definition**
List of X Client and/or XDMCP definitions to launch as a group.

**Public launch group definition**
(domain mode only) A launch group definition created by the administrator, and available to all users in the domain. Only the administrator can modify the items in this list.

**Session definition**
Configuration settings for a session.

**Public session definition**
(domain mode only) Session definition created by the administrator, and available to all users in the domain. Only the administrator can modify the settings in this shared definition.

**Running session that is being viewed**
The session has been started, and is currently being viewed on this computer.

**Running session that is not being viewed**
The session has been started, but is not currently being viewed on this computer.
When working with Fonts, Secure Shell Keys, and Color Schemes, the following icons display:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Trashcan icon" /></td>
<td><strong>Trashcan</strong></td>
</tr>
<tr>
<td><img src="image" alt="User key icon" /></td>
<td><strong>User key</strong> Secure Shell user key pair for connection to X clients.</td>
</tr>
<tr>
<td><img src="image" alt="Trusted host key icon" /></td>
<td><strong>Trusted host key</strong> Secure Shell host public key for connections to X clients.</td>
</tr>
<tr>
<td><img src="image" alt="Public trusted host key icon" /></td>
<td><strong>Public trusted host key</strong> Secure Shell host public key created by the administrator, and available to all users in the domain.</td>
</tr>
<tr>
<td><img src="image" alt="Font collection icon" /></td>
<td><strong>Font collection</strong> Font file set collection for use by X servers.</td>
</tr>
<tr>
<td><img src="image" alt="Public font collection icon" /></td>
<td><strong>Public font collection</strong> Font file set collection created by the administrator, and available to all users in the domain.</td>
</tr>
<tr>
<td><img src="image" alt="Color scheme icon" /></td>
<td><strong>Color scheme</strong> Configuration settings for colors in a color scheme, which can be used by an X server.</td>
</tr>
<tr>
<td><img src="image" alt="Public color scheme icon" /></td>
<td><strong>Public color scheme</strong> Color scheme created by the administrator, and available to users in the domain.</td>
</tr>
<tr>
<td><img src="image" alt="Keyboard map icon" /></td>
<td><strong>Keyboard map</strong> Configuration settings for keyboard actions.</td>
</tr>
<tr>
<td><img src="image" alt="Public keyboard map icon" /></td>
<td><strong>Public keyboard map</strong> Keyboard map created by the administrator, and available to users in the domain.</td>
</tr>
</tbody>
</table>

The following icons appear in the X Administrative Console.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Set user password icon" /></td>
<td><strong>Set user password</strong> Available from the Authentication pane when Authentication system is set to Internal.</td>
</tr>
<tr>
<td><img src="image" alt="Registered node (online) icon" /></td>
<td><strong>Registered node (online)</strong> On the Domain Composition pane. Indicates that the listed domain node is online.</td>
</tr>
<tr>
<td><img src="image" alt="Registered node (not online) icon" /></td>
<td><strong>Registered node (not online)</strong> On the Domain Composition pane. Indicates that the listed node is not available.</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

How do I start my X client?

You can use the default sample definitions to help you get started. See “Launch an X Client Application Using the Sample Definitions” on page 22. Once you have a client definition, there are a variety of ways to start the client from X Manager and X Manager for Domains: double-click the definition, select the definition and click the start arrow on the toolbar, right-click the definition and select Start, or use the Action > Start on the menu. If the client does not have a default session configured, you'll be prompted to select a session. You can also use shortcuts and command-line options to start clients.

I see "Client failed to connect to the X server" when I try to make a connection. How can I troubleshoot this problem?

If you see this message in the status bar it means that Reflection X Advantage was able to connect to your host, but that the command specified to launch the client isn't valid on your host. This can mean that the X client application isn't in the directory path given, or that it isn't available on your host. The Command box in the Client Definition pane includes a drop-down list of sample commands. The list of sample commands changes based on one the current value for Host type. If Host type is set to Generic UNIX, change it to match your host type and try other sample commands. To launch an X client that isn't in the list determine the correct path to your client application and edit this portion of one of the sample commands.

Configuring and starting a client is different from earlier versions. What has changed? Will settings I created with an earlier version still work?

In Reflection X Advantage versions 5.0 (and greater), it's easier to configure and start sessions than in earlier versions. You can use your client definitions to start an X server and connect to your host. Your existing settings are updated automatically to work correctly – just double-click your migrated X client or XDMCP definitions to get started.

How and where are my settings saved?

Settings are saved automatically to the Reflection X Advantage database (page 83) while you work.

Can I undo an action?

There is no undo option for edits you've made to a definition. However, you can easily recover deleted definitions. Click the definition trashcan icon , or go to File > Definition Trashcan. This opens a dialog box with a list of deleted definitions. You can select any item on the list and click Restore Item. By default, the trashcan is deleted when you exit. You can modify this behavior using File > Preferences.

Should I use standalone or domain mode?

Standalone mode is provided by a single application—X Manager, which is installed by default. In this mode, all you need to do to get started is install using defaults. Sample settings are included that make it easy for you to get connected to your host applications. Running Reflection X Advantage in Domain mode provides access to all the features in standalone mode, and also provides access to additional domain services. These additional services include support for centralized configuration of settings, the ability to leave sessions running and rejoin them in progress from the same computer or another computer in the domain, and fault tolerance to ensure that running sessions remain available even if your system crashes or you lose your connection. For a comparison of features, see Operating Modes: Domain vs. Standalone. (page 8) For diagrams showing some typical domain configurations, see Sample Domain Configurations. (page 51)
How do I set up a Reflection X Advantage domain?

To configure a domain, you'll need to install a domain controller and Administrative Console; add domain nodes; and install X Manager for Domains on user workstations. For details, see Setting up Domain Components. (page 41)

Why can't I edit a client or session definition?

If you are running X Manager for Domains, you may see public client and session definitions that have been made available to you by the domain administrator. You can use these to start sessions, but only the administrator can edit them.

Who can share definitions?

The ability to create public definitions (page 122) is available when using the Reflection X Advantage Administrative Console, and is limited to administrators only. This feature is not available in standalone mode. In either mode it is possible to export and import definitions to share them with other users.

Can I share my display?

Anyone can share a display from either X Manager or X Manager for Domains. Select the running session and look at the Session Status section on the right.

If you are running X Manager, click Share. This generates a connection URL. Click Copy URL to copy this and send it to other users, who can join your session using Action > Join.

If you are running X Manager for Domains, edit the Allowed Users list. Users you add here will see your session under Offered Sessions.

Can I edit my client and session definitions while a session is running?

Yes. The changes you make do not affect running clients and sessions, but are applied the next time you start the client or session.

What happens when I start a session?

Starting a session starts an X server that will display your X client applications and receive keyboard and mouse input. Starting a session also starts session processes (page 38) that manage client connections and protocol routing. You can start a session before you start your clients, but you won't see a display until you start a client.

What happens when I start an X client or XDMCP connection?

A session must be running before Reflection X Advantage can display your X client application or desktop. When you start an X client or XDMCP connection, Reflection X Advantage checks to see if the definition specifies a default session. If there is no default session, you're prompted to select one. If there is a default session, Reflection X Advantage checks to see if it is already running and starts it if it isn't. Once the session is running, Reflection X Advantage starts your client and displays it using the settings you've configured for that session.

Can I configure Reflection X Advantage to start my sessions and client applications automatically?

Yes, each definition type includes a setting to start that definition automatically when you start X Manager or X Manager for Domains. For example, if you select Automatically start session in your session definition, the session starts automatically. This can save time when you launch your clients. It is also useful if you prefer to start clients from a terminal session; you can start X Manager and run it in the background, knowing that your X server is automatically running and available.
What is a launch group?

A launch group provides a way to start multiple applications. You can add any defined X clients or XDMCP connections to a group, and all added items start when you start the launch group. If you enable Automatically start launch group, all your applications start automatically when you start X Manager or X Manager for Domains.

Administrator questions

How can I create and deploy custom settings to end users?

In domain mode, create and share public sessions. (page 56) In standalone mode, use Management and Security Server (sold separately) to deploy settings. In both domain mode and standalone mode, install custom templates. (page 66) For more information about these options, see Deploying Settings - Overview. (page 62)

Can I use a command line to start Reflection X Advantage?

Yes, use rxmgr (page 93) to start X Manager and rxmgrdomains (page 95) to start X Manager for Domains. These command-line utilities include options for starting specific clients and sessions, and also for limiting user access to the user interface.

Can I provide users with read-only access to settings and prevent users from creating their own settings?

You can do this using the rxmgr (page 93)and rxmgrdomains (page 95) command-line utilities. Use the -execOnly option to launch Reflection X Advantage in a slimmed-down mode that enables user to see and use the definitions you have provided without allowing access to features for editing settings.

Related Topics

- “Troubleshooting” on page 111
In standalone mode, by default all session components run on the same system as X Manager. If your connection to the host system is slow, you may be able to improve performance by using Remote Session Services feature to configure a distributed session.

In this Chapter
- “X Manager Basic Session” on page 33
- “X Manager (Standalone) Distributed Session” on page 34
- “How to Configure a Distributed Session in Standalone Mode” on page 35

**X Manager Basic Session**

X Manager (the standalone session manager) is installed by default. When you run sessions from X Manager, all processes initially run on the X Manager workstation, data flows directly between the X Manager and the X client host, and the server display is created on the X Manager. (By sharing your session, you may create additional X server displays on remote computers.)

**NOTE:** All definitions used by the standalone X Manager are stored in the Reflection X Advantage database (page 83) on the X Manager workstation.

1. When you start X Manager, it retrieves session settings from the database on your workstation.
2. When you launch a session, a client connector and protocol router are created on your workstation, and X client applications connect to the client connector.
3. The X server display is created on your workstation, and all X protocol passes between the two computers.
If you are running the standalone X Manager (which is installed by default), you can use the Remote Session Services feature to configure distributed sessions. A distributed session can improve performance where high “latency” on page 122 or low bandwidth is a problem in your network (typically because your X client host is located far from your X Manager workstation). This configuration can also resolve problems using XDMCP when you are connecting through a VPN.

To configure a distributed session, you use the Remote session services setting on the General tab of the session definition. To support this functionality from the standalone X Manager, you need to install the Remote Session Services feature on the X client host or on a UNIX computer with a fast connection to that host, and configure your session to run on this host. For details, see “How to Configure a Distributed Session in Standalone Mode” on page 35.

NOTE: All definitions used by the standalone X Manager are stored in the Reflection X Advantage database (page 83) on the X Manager workstation.

Here is the sequence of events on a high latency network when Remote session services is set to High-latency network performance. In this example the Remote Session Services feature is installed and running on the X client host.

1. When you start X Manager, it retrieves session settings from the database on your workstation.
2. When you launch a session, a client connector and protocol router are created on the X Client host, and X client applications connect to the client connector.
3. The X server display is created on your workstation. Reflection X Advantage automatically measures the latency of the connection between the protocol router and the X server display, and creates a headless X server on the X client host if the delay is significant enough to affect performance. Only those X protocol commands that are required for the updating the display pass between the two computers.

NOTE: In high latency networks, this configuration improves performance by short circuiting some of the data exchange over the network. With the headless X server running on the client host, client/server exchanges that don't affect the display pass between the client and the headless X server, but aren't sent on to the X server display on the workstation. This reduces the number of round trip network messages, and this can improve the response time you see on your workstation. In addition, if the network exhibits low bandwidth, the protocol is compressed between the protocol router and the X server display.
How to Configure a Distributed Session in Standalone Mode

You can use remote session services to improve performance where your network configuration causes delays that make running a remote X client application difficult. This configuration can also resolve problems using XDMCP when you are connecting through a VPN.

Before you begin

- Install X Manager on the user's workstation. This feature is installed by default.
- Log on as root to the X client host (or a UNIX system with a fast connection to this host) and install Reflection X Advantage (page 13). Install the Remote Session Services feature.

To configure and start your session

1. From the user's workstation, start X Manager.
2. Under Session Definitions, create a new session (or select an existing session). In the General tab, under Remote session services, do the following:
   - Select High-latency network performance.
   - For Host name specify the name of the computer on which you installed Remote Session Services.
   - (Optional) For User name and Password, specify valid credentials on this computer. Note: The password is saved in clear text in the database.
3. Under X Clients or XDMCP Connections, create a new definition (or select an existing one) and enter the required connection information. For Default session, use the drop-down list to select the Remote Session Services session you just configured.
4. Start your X client or XDMCP connection.

   If you did not specify a password under Remote Session services in the session definition, you'll see two prompts. The first is to authenticate to the Remote Session Services host. This is followed by a second prompt (if required) to authenticate to the X client host. If you don't want to save your password, and you're running Remote Session Services on the same host as the X client, you can avoid the second prompt by configuring single sign-on, as described in the next procedure.

   In the Session Status display for your running session, under X Servers, you will see an entry for your workstation computer. If high latency is detected in your network connection, you'll see an additional entry for the headless X server. The headless X server will be located on the remote session node.

The next procedure uses a client connection method called "Remote Session Services." This connection type lets you authenticate with a single logon prompt without requiring you to save your password.

To configure single sign-on for sessions using remote session services

1. Under X Clients, select the client that uses your Remote Session Services session.
2. Set Connection method to "Remote Session Services."
5 Domain Administration

A Reflection X Advantage domain consists of one or more computers on which X session components run and are load-balanced. The domain also defines a group of users who can run and share sessions on those computers. All public and private definitions used by X Manager for Domains are stored in the Reflection X Advantage database (page 83) on the domain controller and can be accessed from any computer in the domain.

Reflection X Advantage domains can be set up in many different ways, with several optional components. To review some sample domain configurations, see “Sample Domain Configurations” on page 51.

In this Chapter

- “Reflection X Advantage Domain Components” on page 37
- “Reflection X Advantage Session Processes” on page 38
- “X Manager for Domains Basic Session” on page 38
- “X Manager for Domains Distributed Session” on page 39
- “Setting up Domain Components” on page 41
- “Domain Authentication” on page 47
- “Sample Domain Configurations” on page 51

Reflection X Advantage Domain Components

A Reflection X Advantage domain typically involves more than one computer.

The Administrative Console

Used by domain administrators to set up and centrally manage the domain. This application is typically installed on the domain controller. You can also install it on additional workstations to manage the domain from those computers.

X Manager for Domains

Used by domain users to run and configure sessions.

Domain Controller

The domain controller runs the Reflection X service, including the domain controller process. The service runs continuously and listens for requests to access the domain. The database (page 83) that centrally stores session information is located on the domain controller.

Domain Node

A domain node runs the Reflection X service and supports remote session services. The domain controller can act as a domain node. In addition you can create additional nodes by installing the Reflection X service (without the domain controller feature) and joining the node to the domain using the rxsconfig utility.
Reflection X Advantage Planning and Installation Guide

Reflection X Advantage Session Processes

In Reflection X Advantage, a traditional X server is broken into separate cooperating processes — a client connector and protocol router, and one or more X servers. This combination of processes is referred to as an "X session." These processes may be distributed on one or more computers, depending on your configuration.

Client Connector and Protocol Router

The client connector and protocol router run together on the same computer. The client connector receives X protocol data from the X client application, converts it to a proprietary Reflection X Advantage protocol, and then sends it to the protocol router.

The protocol router serves as the hub of traffic for a Reflection X Advantage session — it transmits the protocol it receives from the client connector to one or more X server displays connected to the session.

X Server

The X server receives and processes data from the protocol router. Reflection X Advantage has two types of X servers:

X server display

This server creates the X client application display and returns user input (for example, keyboard or mouse) to the protocol router, which sends it on to the client program. A shared session may have multiple X server displays.

Headless X server

This server has no physical display, yet processes all X protocol. When enabled, the headless X server can short-circuit inquiry-only requests, removing the need to forward these requests across slow connections to X server displays on user desktops. When a session is suspended, the headless server keeps it alive by continuing to process client requests.

X Manager for Domains Basic Session

A basic session is one in which all session components run on the user's workstation. This is the default X Manager for Domains configuration (Remote session services on the General tab is set to none). Remote session services (such as the ability to suspend and resume session, and improved performance in slow networks) are not available with this configuration. This configuration does support the ability of a domain administer to provide users with predefined public session definitions. In addition, users can configure and run their own private sessions.

Here is the sequence of events when Remote session services is set to none:

1. When a user logs on to a domain, the domain controller authenticates the user, after which the user can access session definitions stored in the domain database.
When the user starts a session, the domain controller sets up the session components on the user's workstation. (See the arrow labeled 2 in the following illustration.)

The X protocol flows directly from the X client to the session on the workstation. (See the arrow labeled 3 in the following illustration.)

**X Manager for Domains Distributed Session**

Reflection X Advantage sessions that use Remote session services can have several advantages over basic sessions, including session persistence and improved performance in high latency or low bandwidth networks.

All of the following Remote session services options create a distributed session. In a distributed session, the client connector and protocol router are created on a remote domain node, not on the workstation running X Manager for Domains. Each of these options also supports creating a headless X server on that domain node. The difference between the options is in how they control creation of the headless X server.

- **Session suspend/resume**
  A headless X server is created on the domain node only when you leave the session or close X Manager for Domains. This enables you to rejoin the session at a later time.

- **Session suspend/resume; High-latency network performance**
  Reflection X Advantage automatically measures the latency of the connection and creates a headless X server if the delay is significant enough to affect performance. The headless X server helps improve performance by reducing the amount of data that needs to pass over the network.
**Session suspend/resume; High-latency network performance; Network fault tolerance**

This option forces creation of a headless X server whenever the session is running. This can improve performance where high-latency is a concern and also ensures that the session remains running even if a workstation is disconnected due to a power or network failure.

Here is a sample sequence of events when **Session suspend/resume; High-latency network performance; Network fault tolerance** is enabled.

1. The user logs into the domain. (See the arrow labeled 1 in the following illustration.)
2. When the user starts a session, the domain controller sets up the session processes (a client connector, protocol router, and a headless X server) on a domain node. (See the arrow labeled 2 in the following illustration.) It also starts an X server display on the user's workstation (shown in the second illustration).
3. The X client establishes a connection with the client connector. All X protocol passes to the headless X server on the domain node. (See the arrow labeled 3 in the following illustration.)
4. The X protocol required to update the display is passed on to the X server display on the workstation. (See the arrow labeled 4 in the following illustration.)
NOTE: In high latency networks, this configuration improves performance by short circuiting some of the data exchange over the network. When a headless X server is running, client/server exchanges that don't affect the display pass between the client and the headless X server, but aren't sent on to the X server display on the workstation. This reduces the number of round trip network messages, and this can improve the response time you see on your workstation.

Compression to Remote Workstations

If you are connecting over a low bandwidth network, protocol compression can improve performance. Reflection X Advantage is configured by default to compress protocol to remote X servers automatically whenever it detects low bandwidth (Compress protocol to remote X server displays = Dynamic). When you configure a distributed session (as shown above), the protocol that passes between the domain node and the workstation (identified with the label 4 in the diagram above) will be compressed automatically if low bandwidth is detected.

Setting up Domain Components

Use the information in this section to set up the domain controller, start and stop the Reflection X Advantage service, set up administrator and user workstations, set up and remove domain nodes, and manage session persistence and performance.

In this Section

- "Set Up the Domain Controller" on page 41
- "Start and Stop the Reflection X Service" on page 42
- "Set Up an Administrator Workstation" on page 43
- "Set Up Domain Nodes" on page 43
- "Remove a Domain Node" on page 44
- "Set Up User Workstations" on page 45
- "Manage Session Persistence and Performance" on page 46

Set Up the Domain Controller

Each Reflection X Advantage domain requires one domain controller. You can run the domain controller on any supported platform.

To set up the Reflection X Advantage domain controller

1. Install the following features:
   - X Administrative Console
   - Domain Services (including the Domain Controller feature)
   - Java Runtime Environment (JRE) (Windows only)

NOTE: The Reflection X Service, configured to run the domain controller, starts automatically.

To create an administrator's account for the domain, you'll log into the domain using the X Administrative Console.
To log on to the domain the first time

1. From the domain controller, start the X Administrative Console.
   You'll see the domain logon dialog box.
2. Enter the following information to log on to the domain:
   - For **User name** and **Password**, specify any user who can log onto your computer. The name you specify for your initial login will be the default domain administrator.
   - For **Domain**, enter the name of this computer. The Reflection X Advantage domain name is always the same as the name of the computer running the domain controller.

   **NOTE**: On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X Advantage.

   On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X Advantage domain using root credentials.

3. From the tabs located along the left-hand side of the window, click **Authentication**.
   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X Advantage domain administrator.

Start and Stop the Reflection X Service

The Reflection X Service (RXS) starts automatically when you install it, and when the computer reboots. However, you may need to stop or restart the service as part of a troubleshooting procedure.

**NOTE**: If X Manager for Domains or the Administrative Console is open, you should log off before you stop or restart the Reflection X Advantage service.

To start, stop, or restart the Reflection X Service

<table>
<thead>
<tr>
<th>System</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Open the Windows Services Management Console. (From Control Panel, go to Administrative Tools &gt; Services.) Select Micro Focus Reflection X Service to start, stop, or restart the service.</td>
</tr>
<tr>
<td>UNIX and Linux</td>
<td>You can start, stop, or restart the service from the command line via the init.d system using the rxs command. For example:</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rxs start</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rxs stop</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rxs restart</td>
</tr>
</tbody>
</table>

The path to init.d depends on your operating system:

- **Default**: /etc/init.d
- **HP-UX**: /sbin/init.d
- **Red Hat**: /etc/rc.d/init.d
Set Up an Administrator Workstation

A Reflection X Advantage domain administrator's workstation can be the domain controller, or any computer that has access to the domain controller.

To set up the administrator's workstation

1. Install the following features:
   - X Administrative Console
   - X Manager for Domains
   - Templates
   - Java Runtime Environment (JRE) (Windows only)

2. Start the X Administrative Console. To log, enter the username and password of the domain administrator. For instructions on creating this administrator account, see “Set Up the Domain Controller” on page 41.

Set Up Domain Nodes

Adding nodes to a Reflection X Advantage domain is optional. Typically, nodes are added in order to support either or both of the following:

- Run sessions on a node at or near a remote X client host to improve performance over a slow network.
- Run sessions on multiple nodes to provide load balancing where remote session services are required by many users.

To add a node to a Reflection X Advantage domain, you'll install the Reflection X Advantage service on the computer you want to add as a node, then use the `rxsconfig` utility to add this computer to the Reflection X Advantage domain. You can create a node on any supported platform.

Before you begin

- “Set Up the Domain Controller” on page 41.
- Know the name of the computer running the domain controller (this is the domain name for your Reflection X Advantage domain), and the user name and password of the Reflection X Advantage domain administrator.
- Have administrator (or root) credentials for the computer you want to add as a node.

To set up a domain node

1. Log onto the computer you want to designate as a node using an administrator (or root) account.

System Procedure

AIX

On AIX, you can start or stop the service via the System Resource Controller (SRC) by entering one of the following commands.

```
startsrc -s rxs
stopsrc -s rxs
```

To restart the service, you must enter the stop command followed by the start command.
2 Run the Reflection X Advantage installer and select the feature called Domain Services (without including the Domain Controller feature). If you are running on Windows, also confirm that Java Runtime Environment (JRE) is selected. (For information about downloading and launching the installer, see "Install Reflection X Advantage on Windows" on page 11 or "Install on UNIX" on page 13.)

3 Open a Command Prompt window (Windows) or terminal window (UNIX).

4 Run the following command, where "domainname" is the name of the computer running the domain controller.

```bash
rxsconfig join domainname
```

Note: On UNIX systems, include full path information for `rxsconfig`. The default install location is shown in this example:

```bash
/opt/rxadvantage/rxsconfig join domainname
```

5 You'll be prompted for Administrator credentials. Enter the user name and password of the Reflection X Advantage domain administrator. You'll see a message saying that node was successfully created. In this example, the node uses the default port, 22001.

```bash
C:\>rxsconfig join domainname
Initializing crypto library...
Performing the join...
Administrative user for domain: joe
Password:
Created node 0.0.0.0:22001 for domain domainname.
```

6 On the computer on which you have installed the Reflection X Advantage Administrative Console, open the Console and log on using the domain administrator credentials. Click the Domain Composition side tab.

You should see the node you just created listed under Registered Nodes.

7 (Optional) Edit the Registration Details for this node.

   **NOTE:** The Participate in domain setting is selected by default. This is required for domain participation. If you clear this setting, existing sessions can continue to run but new sessions won't be able to use this node.

8 (Optional) If you are adding multiple nodes, select a Load balancing scheme.

   **NOTE:** You can configure the domain controller to act as a domain node. To do this, use the procedure above, omitting step 2.

---

**Remove a Domain Node**

Use the `rxsconfig` (page 99) command line utility to remove a node from a domain.

**To remove a domain node**

1 Log onto the computer that is currently configured to be a Reflection X Advantage domain node using and administrator (or root) account.
2 Open a Command Prompt window (Windows) or terminal window (UNIX).

**NOTE:** For newer Windows systems (starting with Windows Vista and Windows Server 2008), you need to open the command window as an administrator. (In the Start menu, under Accessories, right-click Command Prompt and select Run As Administrator).

3 Run the following command, where "domainname" is the name of the computer running the domain controller.

```bash
rxsconfig leave domainname
```

Note: On UNIX systems, include full path information for `rxsconfig`. The default install location is shown here:

```bash
/opt/rxadvantage/rxsconfig leave domainname
```

4 You'll be prompted for administrator credentials for the domain. Enter the user name and password of the Reflection X Advantage domain administrator. You'll see a message saying that node was successfully deleted.

**NOTE:** You can remove a domain node from the list under Registered Nodes in the Domain Composition tab of the X Administrative Console. If you do this, the node is no longer available to computers in your domain, but this change does not affect the configuration of the domain node. On that computer, the Reflection X service continues to run and listen on the port specified when the domain node was created. Using `rxsconfig` stops the listening process.

---

**Set Up User Workstations**

To run sessions in domain mode, install X Manager for Domains and log onto the domain.

**To set up user workstations**

1 Install the following feature.
   - X Manager for Domains
   - Templates
   - Java Runtime Environment (JRE) (Windows only)

2 Start X Manager for Domains.
   - You'll see the domain logon dialog box.

3 Log on to the Reflection X Advantage domain.
   - For **Username** and **password**, enter your credentials to log onto the Reflection X Advantage domain. If your domain is configured to use the default authentication option (Windows authentication on Windows systems and PAM authentication on non-Windows systems), you can log on using the same credentials you use to log on to your computer.
   - For **Domain**, enter the Reflection X Advantage domain name. (The Reflection X Advantage domain name is always the same as the name of the computer running the domain controller.)

**NOTE:** From X Manager for Domains you can access any public session definitions that have been created in this domain. You can also configure your own private session definitions, which are not visible to other users. All session definition information is stored on the domain controller in the domain database.
Manage Session Persistence and Performance

If you are running in domain mode, you can use Reflection X Advantage remote session services to provide both session persistence and improved performance on some networks. Remote session services are configured on a per session basis from X Manager for Domains or the Administrative Console. These settings determine when and where sessions are held in memory.

NOTE

- The default Remote session services setting is None. To use any of the other remote session services, you must be connected to a domain with at least one domain node (page 43) available.
- When you exit X Manager for Domains, your currently running sessions may stop or they may continue to run as suspended sessions. What happens depends on your setting for Remote Session Services, your setting for On exiting X Manager, and whether or not you leave the session before you exit X Manager for Domains. For example, if Remote Session Services = Session/suspend resume, On exiting X Manager = Stop all sessions, and you exit X Manager for Domains with a session window still open, Reflection X Advantage automatically stops the session. If On exiting X Manager = Leave all sessions if possible and you exit X Manager for Domains with a session window still open, or with a session suspended, the session will continue to run as a suspended session.

To configure remote session services

1. Start X Manager for Domains.
2. Select a session. On the General tab, under Remote session services, select one of the following settings:

   None (Default)
   
   With this option, your session runs on your workstation, and remains available as long as X Manager for Domains is running. The session ends when you close X Manager for Domains or your workstation shuts down.

   Session suspend/resume
   
   Use this option to be able to rejoin a session even after you close X Manager for Domains and shut down your workstation.

   NOTE: With this configuration, your session does not persist if your workstation shuts down unexpectedly.

   Session suspend/resume; High-latency network performance
   
   Use this option to improve performance when you connect to an X client over a high-latency network (typically one in which your X Manager for Domains workstation is located far from the X client host computer).

   NOTE: With this configuration, your session may not persist if your workstation shuts down unexpectedly.

   Session suspend/resume; High-latency network performance; Network fault tolerance
Domain Administration

To use the domain features you need to log into the Reflection X Advantage domain. When you start X Manager for Domains and the X Administrative Console, you'll be prompted for your domain credentials. The required credentials depend on how domain authentication is configured.

Reflection X Advantage supports the following authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Advantage Internal.

In this Section

- “How Domain Access is Controlled” on page 47
- “Configure and Test User Authentication” on page 48
- “Set Up LDAP Authentication” on page 49
- “Set Up Reflection X Advantage Internal Authentication” on page 49
- “Add or Remove Domain Users” on page 50
- “Unlock a Domain” on page 50

How Domain Access is Controlled

You can leverage your existing authentication process to provide Reflection X Advantage authentication. The default Reflection X Advantage authentication method depends on the operating system of the computer on which you installed the domain controller.

You can set up your authentication system either to add users to the domain automatically when they log on, or to require that users must be added individually. (Requiring individual assignments allows you to provide access to only a subset of known users.)

Reflection X Advantage supports the following authentication methods:

- **Windows**
  The default authentication system when the Reflection X domain controller is installed on a Windows system.

- **PAM (Pluggable Authentication Modules)**
  This is the default authentication system when the Reflection X domain controller is installed on UNIX or Linux systems.

- **LDAP (Lightweight Directory Access Protocol)**
  A generic way of authenticating users that can be used with a number of directory servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.
Reflection X Internal

A lightweight mechanism for authenticating users. The Reflection X Advantage administrator manually maintains a list of users.

NOTE: Automatically adding users is supported for all authentication methods except the Internal method.

Configure and Test User Authentication

Use the Administrative Console to test and configure user authentication. Basic procedures to help you get started are outlined here. For additional information, see “Domain Authentication” on page 47.

If you install your domain controller on a computer that is joined to a Windows domain, users with accounts in the same Windows domain can log onto the Reflection X Advantage using their Windows domain credentials. No additional configuration is needed. You can use the following procedure to test user authentication to the Reflection X Advantage domain.

To test authentication using Windows credentials

1. Start Reflection X Advantage Administrative Console and log on to the Reflection X Advantage domain.
2. From the tabs located along the left-hand side of the window, click Authentication.
3. Click Test Authentication to test credentials for any valid Windows domain user.

If you install your domain controller on a UNIX system, PAM authentication is used by default. Any user who can log onto the UNIX computer can log onto the Reflection X Advantage domain. You can use the following procedure to test user authentication to the Reflection X Advantage domain.

To test authentication on UNIX systems

1. Start Reflection X Advantage Administrative Console and log onto the Reflection X Advantage domain.
2. From the tabs located along the left-hand side of the window, click Authentication.
3. Click Test Authentication to test credentials for any valid account on the UNIX computer.

The internal authentication system is a light-weight authentication system that is available on all supported platforms. You may find it useful for testing or to set up a domain for a small group of users.

To configure Internal authentication

1. Start Reflection X Advantage Administrative Console and log onto the domain.
2. From the tabs located along the left-hand side of the window, click Authentication.
3. Set Authentication system to Internal.
4. Select a username, then click 🗝️ (or Action > Set user's password) to set the password in the Internal authentication database.

NOTE: Although an administrator account was created when you first logged on, the internal authentication database has no record of your password for this account because authentication was handled by Windows or PAM. You need to manually add users and set passwords when you use Reflection X Advantage Internal authentication. This is not required for the other
authentication methods because authentication for Windows, PAM, or LDAP is managed by those systems. If you change to Internal authentication from the default authentication, any user who was added automatically will not be able to log on until you set a password for that user.

5 Click Test Authentication and test your credentials to confirm that you can still log on to the domain using this account.

CAUTION: After changing the authentication system, always test the administrator account before you log off. Without a valid administrator account, you won’t be able to log on to the domain. (If you do find yourself locked out of your domain, a recovery option (page 50) is available.)

6 Click (or Action > New User) to add additional users to your domain. Enter a username and password for each user.

Set Up LDAP Authentication

LDAP (Lightweight Directory Access Protocol) offers a generic way of authenticating users and can be used with a number of Directory Servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.

Before you begin

- Add the computers that you have designated as domain components to the domain and configure the components.

CAUTION: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you do find yourself locked out of your domain, a recovery option (page 50) is available.)

To set up LDAP authentication

1 On the computer on which the Reflection X Advantage Administrative Console is installed, use the Administrative Console to log on to the domain.
2 From the Authentication tab, in the Authentication system list, select LDAP and then click Configure.
3 From the LDAP Configuration dialog box, enter the configuration data for your LDAP server.
4 After you change authentication methods, make sure the domain has an administrative account and password that you can use to log on to the domain.
5 Click Test Authentication to make sure the account is valid.

Set Up Reflection X Advantage Internal Authentication

The Internal authentication system is a lightweight mechanism for authenticating users.

Before you begin

- Add the computers that you have designated as domain components to the domain and configure the components.
CAUTION: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you do find yourself locked out of your domain, a recovery option (page 50) is available.)

To set up Reflection X Advantage Internal Authentication

1. On the computer on which the Reflection X Advantage Administrative Console is installed, use the Administrative Console to log on to the domain.
2. From the Administrative Console Authentication tab, in the Authentication system list, select Internal.
3. On the User Accounts list, click +, and then from the Add user to domain dialog box, enter a user name and password for your administrative account.
4. In the Administrator column, choose to provide administrative permissions for the account.

Add or Remove Domain Users

You can set up your Reflection X Advantage domain so that users are automatically added to the domain when they log on. (This is supported for all authentication systems except the Internal system.) If you want to have more control over access, you can set up the domain so that users must be added or removed individually.

To allow access to all users in external authentication system

- In the Reflection X Advantage Administrative Console, from the Authentication tab, select Automatically create user account after successful logon.

All users who are in the authentication system are allowed access to the Reflection X Advantage domain. The first time a user logs on to the domain, his or her user account is added to the domain.

NOTE: If you are using Reflection X Advantage Internal Authentication, you cannot automatically create accounts when users log on.

To allow access to selected users only

1. In the Reflection X Advantage Administrative Console, from the Authentication tab, clear Automatically create user account after successful logon.
2. To add a user, on the User Accounts list, click +, then, from the Add User to Domain dialog box, enter the user name and password (if you are using Internal authentication) you want to add.
3. To give the new user account administrative permissions, select the box in the Administrator column.
4. To remove a user, in the User Accounts list, select the user name to remove and click –.

Unlock a Domain

You can be locked out of a domain if you forget the administrator password, change authentication methods without adding an administrative account, or experience a problem with the external authentication system.

You can unlock the domain using the rxsconfig (page 99) command line utility's recovery option.
To unlock a domain using rxsconfig

1 Log on the server on which the Domain Controller is installed as an administrator (Windows) or root (UNIX).
2 Open a command window.

**NOTE:** On Windows systems (starting with Windows Vista and Windows Server 2008), you need to open the command window as an administrator. (In the Start menu, under **Accessories**, right-click **Command Prompt** and select **Run As Administrator**).

3 Enter the following command:

   rxsconfig recover

4 **Restart the service (page 42).**

5 Open the Administrative Console and log on to the domain with the following user name and password:
   
   **user name:** recovery  
   **password:** recovery

   **NOTE:** Running the recover command allows access to the Administrative Console only once. After you log out, these login values for username and password won't work again. To log in again with these values you need to repeat steps 1 through 3.

6 Set **Authentication system** to the authentication system you want to use for the domain.

7 Click the plus sign (➕) to add a new administrative user account.

8 Select the check box under **Administrator** for the new account.

9 Click **Test Authentication** then enter the name and password for this account and click **Test** to make sure that the account is valid.

**CAUTION:** Don't close the Administrative Console without first redefining and testing an administrative account. Without a valid administrative account, you won't be able to log back into the Administrative Console and you'll need to repeat this procedure from the beginning.

Sample Domain Configurations

These sample configurations show how to set up domains that offer solutions to common problems.

**In this Section**

- “Domain Setup: Improve Performance Over a Slow Network” on page 51
- “Domain Setup: Leave a Session and Rejoin from a Different Computer” on page 53
- “Domain Setup: Centralize Session Configuration” on page 56

**Domain Setup: Improve Performance Over a Slow Network**

This sample configuration demonstrates how you can configure a Reflection X Advantage domain to improve performance where your network configuration causes delays that make running a remote X client application difficult.
**NOTE:** This configuration uses Reflection X Advantage domain components to provide remote session services for connections from X Manager for Domains. You can also configure remote session services for connections from the standalone X Manager. For details, see “How to Configure a Distributed Session in Standalone Mode” on page 35.

In this configuration, the session runs two joined X servers. An X server display runs on the user workstation (1). This server creates the visual display of the X client application. An additional “headless X server” on page 121 (3) runs on a domain node located on or near the X client application. When a session is established, all X protocol passes between the X client application (4) and the headless server. Only the protocol required to update the display is sent to the workstation. Because many X protocol queries don't need to be sent to the workstation, this configuration improves performance by reducing the amount of traffic that needs to pass over the network. Reflection X Advantage also automatically detects low bandwidth conditions, and compresses protocol that flows between the user workstation (1) and the domain node (3).

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User workstation (1)</td>
<td>Runs X Manager for Domains. The X server display is created on this computer.</td>
</tr>
<tr>
<td>Domain controller (2)</td>
<td>Runs the Reflection X Advantage domain controller. (In this example, the Administrative Console also runs on this computer.)</td>
</tr>
<tr>
<td>Domain node (3)</td>
<td>Runs a headless X server.</td>
</tr>
<tr>
<td>X client host (4)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>

**To set up the domain components**

1. On the domain controller, install the following features:
   - X Administrative Console
   - Domain Services (including the Domain Controller feature)
   - X Manager for Domains
   - Templates
   - Java Runtime Environment (JRE) (Windows only)
2 On the domain node, install the feature called Domain Services (without including the Domain Controller feature). If you are running on Windows, also confirm that Java Runtime Environment (JRE) is selected. Use the rxconfig utility to add this node to your domain. For details, see “Set Up Domain Nodes” on page 43.

3 On user workstations, install the following features:
   - X Manager for Domains
   - Templates
   - Java Runtime Environment (JRE) (Windows only)

To configure and start your session

1 From domain controller, start X Manager for Domains and log on.
   - For User name and Password, specify any user who can log onto your computer. The name you specify for your initial login will be the default domain administrator.
   - For Domain, enter the name of this computer. The Reflection X Advantage domain name is always the same as the name of the computer running the domain controller.

   **NOTE:** On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X Advantage.

   On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X Advantage domain using root credentials.

   This initial logon creates an administrative account for the domain (using the default authentication method (page 47) for your system) and imports any settings you select.

2 Create a session definition that supports remote session services. To do this, in the General tab, under Remote session services, select any level of service that includes High-latency network performance.

3 Configure an X client or XDMCP connection and set Session to the session you created in step 2.

4 Start your X client or XDMCP connection.

5 In the Session Definitions list, select the running session to view the Session Status pane. Under X Servers, you will see an entry for your workstation computer. If high latency is detected in your network connection, you'll also see a second, headless X server running on the domain node.

**Doing more with this idea...**

Once you have this basic configuration running, you can build on it in a number of ways. For example:

- Simplify connections for end users by configuring public sessions (page 56).
- Add scalability by adding additional domain nodes.

**Domain Setup: Leave a Session and Rejoin from a Different Computer**

This sample configuration demonstrates how you can configure a personal Reflection X Advantage domain that makes it easy for you to continue working from home on a session you started on your work computer. You can pick up your work exactly where you left off.
The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office computer (1)</td>
<td>Runs the domain controller, X Manager for Domains, and the Administrative Console. You can access your sessions from any computer running X Manager for Domains that has access to this computer.</td>
</tr>
<tr>
<td>Home computer (2)</td>
<td>Runs X Manager for Domains.</td>
</tr>
<tr>
<td>X client host (3)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>

To set up the domain components

1. On your office computer, install the following features:
   - X Administrative Console
   - Domain Services (including the Domain Controller feature)
   - X Manager for Domains
   - Templates
2. From your office computer, start the Administrative Console and log on using your Windows domain credentials. For domain name, enter your computer's name.
3. From the tabs located along the left-hand side of the window, click Authentication.
   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X Advantage domain administrator. For this sample configuration, no additional authentication configuration is needed.
   The next step configures your office computer to act as a domain node. By creating a node, you enable your domain to maintain a suspended session even after you close X Manager for Domains.
4. Open a Command Prompt window (Windows) or terminal window (UNIX) and run the following command:
rxsconfig join localhost

You'll be prompted for Administrator credentials. Enter the user name and password you use to log onto this computer. You'll see a message saying that node was successfully created. In the Administrator Console you can now see your computer listed in the Domain Composition pane under Domain Nodes.

5 On your home computer, install X Manager for Domains.

To configure and start a session at work

1 From your work computer, start X Manager for Domains and log on with the same user name and password you used for the Administrative console. For domain, specify the name of your office computer.

2 Create a session definition that supports suspending sessions. To do this, in the General tab, under Remote session services, select Session suspend/resume.

3 Configure an X client or XDMCP connection and set Session to the session you created in step 2.

4 Start your X client or XDMCP connection and get some work done.

5 When it's time to go home, under Session Definitions, right-click the running session and click Leave.

6 Close X Manager and leave this computer running.

NOTE: Because you enabled session persistence and left the session running, the server remains active even though it is no longer producing a display. To confirm this, you can start the Administrative Console, click the Domain Status tab and view Running Sessions.

To join your session in progress from your home computer

1 Confirm that your home computer has network access to your running computer at work.

2 Start X Manager for Domains and log on with the same user name and password you used on your office computer. For domain, specify the name of your office computer.

3 Right-click your running session and click Join.

Persisting a Session on the X Client Host

In the configuration shown above, the session components run on your office computer, which means that you need to leave that computer running if you want to rejoin the session from home.

Another possible configuration is shown below. In this configuration, the domain controller and domain node run on the same computer that runs the X client application. To configure this, install the domain controller on the X client host and create a domain node on that host. With this setup, you can shut down both your home and office computer, and the session will remain active on the X client host.
Domain Setup: Centralize Session Configuration

This sample configuration demonstrates how an administrator can use a Reflection X Advantage domain to simplify session setup for end users. In this example, the administrator configures public session definitions. End users can launch these public sessions from their workstations, and can also create and start their own sessions.

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Workstation (1)</td>
<td>Runs X Administrative Console and X Manager for Domains. The administrator uses these to manage the domain, and to configure and share public session definitions.</td>
</tr>
<tr>
<td>Domain Controller (2)</td>
<td>Runs the Reflection X Advantage domain controller and X Administrative Console. Session information is stored on this computer in the domain controller database.</td>
</tr>
<tr>
<td>User workstations (3)</td>
<td>The user runs public sessions configured by the administrator and can optionally create additional private sessions.</td>
</tr>
<tr>
<td>Domain nodes (4)</td>
<td>(Optional) Run remote session components when sessions are configured to use remote session services.</td>
</tr>
<tr>
<td>X client hosts (5)</td>
<td>The computers that run X applications used in your organization.</td>
</tr>
</tbody>
</table>
The administrator uses the Administrative console (1) to configure the domain controller (2). When users start sessions, the domain controller can set up session components on user workstations (3) or domain nodes (4):

The X server displays are created on user workstations using the centrally managed configurations:
These are the basic steps for setting up this configuration. They are explained in detail below.

Step 1: Set up Reflection X Advantage domain components.

Step 2: Use X Manager for Domains on the administrative workstation to configure and test client and session definitions.

Step 3: Use the Administrative Console to make your definitions public.

Step 4: Use X Manager for Domains on the user workstation to connect using the public definitions.

**Step 1: Set up Reflection X Advantage domain components**

1. On the domain controller, install the following features:
   - Domain Services (including the Domain Controller feature)
   - Java Runtime Environment (JRE) (Windows only)

2. On the administrative workstation, install the following features:
   - X Administrative Console
   - X Manager for Domains
   - Templates
   - Java Runtime Environment (JRE) (Windows only)

3. On user workstations install the following features:
   - X Manager for Domains
   - Java Runtime Environment (JRE) (Windows only)

4. If you are using domain nodes, install Domain Services on these computers (without including the Domain Controller feature). If you are running on Windows, also confirm that Java Runtime Environment (JRE) is selected. Use the **rxsconfig** utility to add each node to your domain. For details, see “Set Up Domain Nodes” on page 43.

**Step 2: Configure and test a session**

In the steps that follow, you'll use X Manager for Domains to configure and test a client and session. It is also possible to these definitions using the X Administrative Console, but starting with X Manager for Domains is recommended because it enables you to test your configuration.

1. From the administrator workstation, start X Manager for Domains and log on.
   - For **User name** and **Password**, specify any user who can log onto your computer. The name you specify for your initial login will be the default domain administrator.
   - For **Domain**, enter the name of this computer. The Reflection X Advantage domain name is always the same as the name of the computer running the domain controller.

   **NOTE:** On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X Advantage.

   On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X Advantage domain using root credentials.

   This initial logon creates an administrative account for the domain (using the default authentication method (page 47) for your system) and imports any settings you select.

2. Configure an X client or XDMCP connection to connect to your X client application or your UNIX desktop.
NOTE: If you are creating new client definitions, you should leave User name blank because you are going to share this session definition with others. After you make this session public, users can enter their name during the connection process.

3 (Optional) If you have configured domain nodes, you can configure a session in which Remote session services is set to something other than None. If you do this, specify this session as the default for your clients.

4 Start your X client or XDMCP connection.

If your connection is successful, you're ready to make this session definition available to other users.

Step 3: Make the session public

By default, a new session is private. A private session definition can be viewed, used, and modified only by the user who created it. To make your session available to other users, you need to make it public.

NOTE: When you make a client definition public, users also need access to the associated session and any other definition used by the client

1 From the administrator workstation, start the Administrative Console and log on using the same credentials you used to log onto X Manager for Domains.

2 Right-click the client definition and select Public. Note that the icon changes to indicate that this is now a public session.

3 If the client reference a session, right click the session definition and select Public.

Now that the administrator's work is done, all a user needs to know to get connected is:

- The name of the Reflection X Advantage domain. (The name of the computer running the domain controller.)
- Logon credentials for the Reflection X Advantage domain. (If you manually added users to the internal authentication database, you need to provide them with these credentials. If you use the default Windows or PAM for authentication, users can log on to the Reflection X Advantage domain using those credentials.)
- Logon credentials for the X client host.

Here's how it works...

Step 4: Make a connection from the user workstation using the public session

1 From the user workstation, start X Manager for Domains.

2 Enter the domain name provided by the administrator. If default domain authentication is used, the username and password required are the same ones you use to log onto this workstation.

3 Double click any public definition to make a connection, then log on to the host.

Doing more with this idea...

As an Administrator, you can further simplify the end-user experience using the Automatically start client setting in your public client definitions. Also ensure that each client has a default session configured. With this configuration, all a user has to do to start your public clients is log into the domain.
6 Customizing and Deploying Reflection X Advantage

Reflection X Advantage supports a number of options for customizing and distributing Reflection X Advantage software, and centrally managing Reflection X Advantage sessions. Review the two overview sections at the start of this chapter to determine which options best fit the needs of your organization.

In this Chapter

- “Deploying Software - Overview” on page 61
- “Deploying Settings - Overview” on page 62
- “Using a Response File to Install on UNIX Systems” on page 64
- “Deploying Sessions Using a Custom Template” on page 66
- “Managing Installations on Windows Workstations” on page 67
- “Deploying Sessions with the Administrative WebStation” on page 78

Deploying Software - Overview

In addition to the basic installation options described under “Installation and Migration” on page 11, administrators can use the following approaches to deploy software to end users. For additional information about deploying customized settings to end users, see “Deploying Settings - Overview” on page 62.

Windows installations

For deployments to Windows systems, you will use the Windows Installer (page 67). You can use the Installation Customization Tool (page 71) to customize your installation.

Features

- Specify which features to install.
- Change the default installation location.
- Customize Windows Start menu shortcuts.
- Chain installations and/or run additional programs automatically with your customized installation.
- Install using silent command line options.

Requirements and limitations

- Deploys to Windows systems only.
- Software is not updated automatically after the install; an additional install must be made available to users.
UNIX installations

For deployments to UNIX systems, you can create a response file to manage customized unattended installations. See “Using a Response File to Install on UNIX Systems” on page 64.

Features

- Specify which features to install.
- Change the default installation location.
- Install using silent command line options.

Requirements and limitations

- Deploys to UNIX systems only.
- Software is not updated automatically after the install; an additional install must be made available to users.

Deploying Settings - Overview

Options for deploying customized settings to end users include:

- Install settings in a companion package (page 62)
- Share settings in a Reflection X Advantage domain (page 62)
- Install custom templates (page 63)
- Import settings using the command line (page 63)
- Distribute settings using Management and Security Server (page 64)

Install settings in a companion package

Deploy using the Windows Installer (page 67). Use the Installation Customization Tool (page 71) to deploy your custom settings.

Features

- Create a companion installer (page 76) to add templates or definition files to your installation.
- Create different companion packages for different users or groups in your organization.
- Configure the companion installer to run automatically with your product installation.
- Install shortcuts to launch Reflection X Advantage using custom command lines.
- Supported in standalone and domain mode.
- Create additional companion installers to add new settings and deploy these separately from the product installation.

Requirements and limitations

- Deploys to Windows systems only.
- Although you can deploy additional companion packages, you cannot modify settings you have already deployed.

Share settings in a Reflection X Advantage domain

Set up a Reflection X Advantage domain to support centralized session configuration. See “Domain Setup: Centralize Session Configuration” on page 56.
Customizing and Deploying Reflection X Advantage

Features
- The domain administrator can provide preconfigured, public definitions for users.
- Updates to centralized definitions are automatically available to users.
- Users can configure and save personal definitions in addition to using public sessions.
- Supported on both Windows and UNIX systems.
- By setting up a domain, you can take advantage of other domain services; such as session suspend/resume, and improved performance in high-latency or low bandwidth networks.

Requirements and limitations
- The domain controller and any required nodes must be installed and configured.
- Supported in domain mode only. X Manager for Domains must be installed on user workstations.

Install custom templates

Use templates to install default definitions on user workstations. See “Deploying Sessions Using a Custom Template” on page 66.

Features
- Create custom definitions and export them to definition files (.rxd). Definition files installed to the templates subfolder in the program installation directory are automatically available to users on initial startup.
- Configure templates to import automatically or provide users with a choice of templates to install the first time they run the application.
- Supported in standalone and domain mode.
- Supported on both Windows and UNIX systems.
- On Windows systems, you can use the Installation Customization Tool to create a companion package to install your templates (page 77).

Requirements and limitations
- Template settings are imported only on first run. They cannot be used to update existing settings, and are not available for upgrading users.

Import settings using the command line

Start Reflection X Advantage using rxmgr (page 93) or rxmgrdomains (page 95), and use the -import option to specify a definition file to be imported.

Features
- A definition file with custom settings can be made available from a shared network drive or a web server.
- Supported in standalone mode (using rxmgr) and domain mode (using rxmgrdomains).
- Supported on both Windows and UNIX systems.
- Changes to the definition file are imported each time the command line is executed.

Requirements and limitations
- The administrator must configure and deploy a shortcut or command-line script for end users.
- Restarting using the import option overrides end-user modifications to imported settings. (The -execOnly option can be used in combination with -import to prevent user edits.)
Distribute settings using Management and Security Server

Configure and launch client connections using the Management and Security Server Administrative WebStation. See “Deploying Sessions with the Administrative WebStation” on page 78.

Features

- Manage sessions for multiple Reflection products from a single console.
- Configure sessions that launch X clients directly, without displaying the X Manager window.
- Provide updated settings to users as needed.
- Connections go through the Management and Security Server Security Proxy server, which provides SSL/TLS encryption to the proxy. The Security Proxy server can also restrict the visibility of your hosts over the network, which enables you to limit host access to authorized users and members of LDAP groups.

Requirements and limitations

- You must have Management and Security Server, which is sold and licensed separately from Reflection X Desktop.
- A Management and Security Server proxy server must be configured, clients must connect using Secure Shell, and Reflection PKI Services Manager must be installed and configured to validate the Security Proxy certificate.
- Administrator and user workstations must be Windows systems, and X Manager (standalone) must be installed on these computers.
- Users who launch sessions from Management and Security Server can't save X Manager settings.

Using a Response File to Install on UNIX Systems

You can use an InstallAnywhere response file to configure automated, silent installs on UNIX workstations.

Before you begin

- Download and unzip the installation file for your UNIX or Linux system as described in “Install on UNIX” on page 13.
- Change permissions on the installation file so that it is executable by root.

To deploy using a response file

1. Use a text editor to create and save a response file. See samples and options below.
2. Log on as root.
3. Launch the installer using a command that specifies your response file (called rxaresponse in this example):

   ```
   /path/rxa-n.n.n.nnn-prod-package-type.bin -f /path/rxaresponse
   ```

Response file format

Use INSTALLER_UI to specify a silent install. Use CHOSEN_INSTALL_FEATURE_LIST to list the features to be installed. CHOSEN_FEATURE_LIST is the list of features enabled. For silent installations these are typically the same. Use USER_INSTALL_DIR to specify the installation directory. All options are required. Leave other options as shown in these examples.
The following sample response file installs all Reflection X Advantage applications and services; and the generic sample template, which automatically imports the default sample settings.

```
INSTALLED_UI=silent
CHOSEN_INSTALL_SET=Custom
CHOSEN_FEATURE_LIST=RX,XMan,XManDom,AdminCon,Service,ServDC,ServRmt,TemplGrp,TemplGen
CHOSEN_INSTALL_FEATURE_LIST=RX,XMan,XManDom,AdminCon,Service,ServDC,ServRmt,TemplGrp,TemplGen
USER_INSTALL_DIR=/opt/rxadvantage
JDK_HOME=
JDK_DOT_HOME=$USER_INSTALL_DIR/$jre
JAVA_EXECUTABLE=$USER_INSTALL_DIR/$jre/bin/java
```

The following response file installs just the Reflection X Advantage service to create a domain node.

```
INSTALLED_UI=silent
CHOSEN_INSTALL_SET=Custom
CHOSEN_FEATURE_LIST=RX,Service
CHOSEN_INSTALL_FEATURE_LIST=RX,Service
USER_INSTALL_DIR=/opt/rxadvantage
JDK_HOME=
JDK_DOT_HOME=$USER_INSTALL_DIR/$jre
JAVA_EXECUTABLE=$USER_INSTALL_DIR/$jre/bin/java
```

Features are organized in a feature tree. To install a feature, include any features above it in the hierarchy. This example installs the Domain Controller:

```
CHOSEN_INSTALL_FEATURE_LIST=RX,Service,ServDC
```
Deploying Sessions Using a Custom Template

Templates are definition files that are installed to the Reflection X Advantage templates folder. Templates are imported for each user the first time the user runs X Manager or X Manager for Domains. Depending on how you create them, definition files may be imported silently or included in the Import Templates and Migrated Settings dialog box that displays on initial startup.

**NOTE:** If you run Reflection X Advantage in domain mode, you can create and share public settings definitions (page 56) instead of (or in addition to) creating and deploying custom templates. Unlike deployed templates, public definitions can be created and modified after X Manager for Domains has already been installed on user workstations.

To create a custom template

1. From X Manager or X Manager for Domains, click **File > Export**.
2. Select the definitions you want to include in the template.
3 Use the Template configuration options to configure how users will import this template.
   - If you want to enable users to select the template from a list, enter a Template name. This name shows up in the list of available templates in the Import Templates and Migrated Settings dialog box that displays on initial startup. (This name is not displayed if Automatically import template on first run is selected.)
   - To configure the template to be imported silently, select Automatically import template on first run.

4 Click Export. Enter a filename and click Save to complete the export process.

5 Put this template in the Reflection X Advantage templates folder. For deployments to Windows systems, you can use Installation Customization Tool to create a companion installer package for your templates and run this package automatically after the product installation. This ensures that templates are available to users on initial startup. See “Install Custom Templates with a Companion Installer Package” on page 77.

Managing Installations on Windows Workstations

If you are installing to Windows workstations, you install Reflection X Advantage using the Setup program (Setup.exe).

You can choose from several different approaches for installing and deploying Reflection X Advantage. Deciding which approach to use is typically based on a variety of factors, including your approved business processes, the scale of the deployment, your deployment tools, and whether you want to customize the installation.

For example, a small-scale deployment might consist of using the Setup program to install Reflection X Advantage on a few workstations, whereas an enterprise-wide deployment would probably involve extensive customization and testing.

Use one of the following approaches, depending on your requirements.

- **Perform a workstation installation on each workstation**
  
  Install all of the files for Reflection X Advantage to a PC hard drive. You might choose this approach if you are installing Reflection X Advantage on a small number of machines and you do not need to customize the installation.

- **Perform a basic deployment**
  
  Perform an administrative installation to copy Reflection X Advantage files to an administrative installation point. This is also referred to as creating an administrative installation image. Then, using deployment tools, you can access these files and create packages that are deployed to workstations. A basic deployment is a good choice when you need to deploy Reflection X Advantage to a large number of workstations, but do not need to customize the installation.

- **Perform a customized deployment**
  
  Perform an administrative installation to copy Reflection X Advantage files to an administrative installation point (just as you would for a basic deployment). Then, customize the installation to specify the way it installs, looks, and acts on the end users' computers. Customized deployments can be deployed to any number of workstations.

In this Section

- “Performing a Basic Deployment” on page 68
- “Performing an Advanced Deployment” on page 68
- “Install from the Command Line” on page 69
Performing a Basic Deployment

Perform a basic deployment when you need to install the default (uncustomized) Reflection X Advantage application on a large number of machines.

The following process is typical for a large-scale, basic deployment:

1. Perform an administrative installation (page 70) in a destination folder to create an administrative installation point.
2. Test the installation.
3. Deploy Reflection X Advantage from the administrative installation point. Because the installation package adheres to MSI standards, you can use Microsoft Active Directory or any other Microsoft Installer-compatible deployment tool.

Performing an Advanced Deployment

The following process is typical for large-scale, customized deployments.

1. Perform an administrative installation (page 70) in a destination folder to create an administrative installation point.
2. From the administrative installation point, start the Installation Customization Tool (page 71). The tool supports two editing modes:
   - Create a companion file (.msi) (page 76). Use this option to install custom files (including templates and other Reflection X Advantage definition files) on user workstations. You can also configure and add custom shortcuts.
   - Create a transform file (.mst) (page 72). Use this option to customize the feature set to be installed on user workstations, to customize Start Menu shortcuts, and to specify additional installation packages to run automatically with installations performed using setup.exe.

   **NOTE:** Details for working with the Installation Customization Tool are available from the tool's Help menu and from context-sensitive help topics for each panel.

3. Test the installation.
4. Deploy Reflection X Advantage using the transforms and companion packages you created. Because the transforms and companion installation packages adhere to Microsoft Windows Installer (MSI) standards, you can use a desktop shortcut, Microsoft Active Directory, or any other Microsoft Installer-compatible deployment tool.
Install from the Command Line

You can use the Setup program command line to install Reflection X Advantage from the distribution image, or from an administrative installation image. You can also include command-line options in a batch file to preset installation parameters, and limit user interaction while Reflection X Advantage is installing. You can even suppress installation dialog boxes to provide an unattended installation.

In addition, you can use command-line options to prepare Reflection X Advantage for installation by users. In general, any of the MSI command-line options can be used from the Setup program command line.

To install from the command line

- At the command prompt or the Start menu Run command, change to the directory in which the setup.exe file resides, and do one of the following:
  - To create an administrative installation image, type:
    
    ```
    setup.exe /install /admin TARGETDIR=path
    ```
    
    where `path` is the path to the administrative installation image on the server.
    
    -or-
    
    - To install to a workstation with typical settings, type:
      
      ```
      setup.exe /install INSTALLDIR=path
      ```
      
      where `path` is the path to the installation directory (`INSTALLDIR==path` is optional).

**NOTE:** To view a list of the command-line options for customizing installations, change to the directory in which the setup.exe file resides and enter:

```
setup.exe /?
```

To install directly with MSI

At the command prompt or Start menu Run command, change to the directory in which the msi file resides and enter:

```
msiexec.exe /i installation_file_name.msi
```

Handling prerequisites in command line installs

If you use `setup.exe` for your install, the setup program checks for any prerequisites required by the features you have selected and installs them automatically.

If you use `msiexec.exe` for your install, prerequisites are not installed automatically. You need to install them separately if they are not already on your users' workstations. You can find installers for Reflection X Advantage prerequisites in the Prerequisites folder in the distribution media, or in your administrative installation. The prerequisites you need to install depend on which programs and features you are installing:

- All Reflection Workspace features require Microsoft .NET Framework 4.5.1. If you attempt an install using `msiexec.exe` and this prerequisite is not found, a message displays and the installer stops. To install the .NET framework, run the executable file in Prerequisites\DotNet451.
The Visual Basic for Applications feature requires Microsoft VBA 7.1. Use the core and language-specific *.msi packages in the Prerequisites\VB71 folder.

All Reflection X Advantage features require a Java Runtime Environment (JRE). Use MicroFocusJava.msi in the Prerequisites\JDK folder to install the JRE. If you install using msiexec.exe without installing this prerequisite, the install will run, but Reflection X Advantage applications will fail to run unless you have configured an alternate JRE.

Handling upgrades in command line installs

If you are upgrading a previous version of Reflection, the prior version must be uninstalled before you can install the current version.

If you use setup.exe for your install, the setup program checks for a previous versions of Reflection and uninstalls it automatically if one is found.

If you use msiexec.exe for your install, you must first manually uninstall any earlier versions. If you upgrade these products by deploying the .msi file directly and have not removed the earlier version, a message displays telling you to uninstall the older software first.

Create an Administrative Installation Point

To prepare your environment for deployment, create an administrative installation point. This is an installation option which installs all of the files required to install Reflection X Advantage as well as the administrative tools used for customization. This installation is different from simply copying the package files to a network location in the following ways:

- Any files that are compressed in the original package are uncompressed in the administrative installation point.
- When a service pack is released, you can update your administrative installation directly by applying the patch to it.

**NOTE:** We recommend that you create an administrative installation point on your administrative workstation *before* installing Reflection X Advantage. After you’ve created an administrative installation point, you can install Reflection X Advantage by running setup.exe from the administrative installation point. If you install Reflection X Advantage before you create the administrative installation, you'll need to create the administrative installation image using the command-line option described below.

To create an administrative installation point

1. Create a network share on a network file server.
2. Click the download link, and run the download program.
3. Select a location for the installer files, and then click Next.
   This extracts the files to the specified location and starts the Installation Customization Tool. (If you have already downloaded the files, click the setup.exe file to start the installation program.)
4. Click Continue and accept the license.
5. From the Advanced tab, click Create an Administrative install image on a server.
   Only selections on the Advanced and File Location tabs apply to this procedure. Selections made on other tabs are ignored. Administrative installations always include all files used by the package.
6. Click Continue.
7 Browse to the network share you want to use for the administrative installation image. For installations on a network share, specify the path to the network share as a UNC path (for example: \\share_name\administrative_install_point).

Administrative installation images are typically created in a file server folder. However, you can create administrative installation images in any folder on a local hard disk. This can be useful for testing purposes.

8 Click Install Now.

To create an administrative installation from the command line

1 Open a command window, running as an administrator.
2 Use the following command syntax to start the installation:

\path_to_setup\setup.exe /install /admin
TARGETDIR=\UNC_path_to_administrative_installation_point

Installation Customization Tool

The Installation Customization Tool is a special mode of Setup program (setup.exe) that supports custom modifications to the primary install and includes some limited deployment facilities. These are accomplished with a simple user interface, and do not require additional software packages or training.

Use the Installation Customization Tool to create transforms or companion installer packages. Each type of customization has its own unique set of configuration panes, depending on your choice from the Select Customization pane.

Open the Installation Customization Tool

To open Installation Customization Tool

1 Create an administrative installation point (page 70).
2 On a command line, navigate to the administrative installation point and enter:

   setup.exe /admin

   -or-

   If you have set up a shortcut to the Installation Customization Tool (page 72), double-click the shortcut.
3 The Select Customization dialog box prompts you to choose which mode you want to open.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new transform file (.mst) (page 72)</td>
<td>Create a new Setup customization file for the following product (the default).</td>
</tr>
<tr>
<td>Create a new companion install package (.msi) (page 76)</td>
<td>Create a new Companion installer.</td>
</tr>
<tr>
<td>Open an existing file of either type</td>
<td>Open an existing Setup customization file or Companion installer.</td>
</tr>
</tbody>
</table>
Set up a shortcut to the Installation Customization Tool

By default, the Installation Customization Tool can be opened only from a command line. However, you can create a file shortcut and set the shortcut properties to open this tool. Although creating this shortcut is optional, you will find that it saves time when you are working with ACT.

To set up a shortcut that opens the Installation Customization Tool

1. On your administrative installation point, right-click the `setup.exe` file then select **Create Shortcut**.
2. Right-click the shortcut and choose **Properties**.
3. In the **Target** field, add the `/admin` option to the end of the command line. For example:
   \myServer\adminInstallPoint\setup.exe /admin

**NOTE:** Make sure that the path in the **Target** field follows the Uniform Naming Convention (UNC) format. Do not use drive letters in the path name — this can cause problems when you try to use the shortcut on other workstations.

4. Rename the shortcut and save it to the desktops of your workstation and the server you are using for your administrative installation point.

Creating and Editing Transforms

You can use Installation Customization Tool to create Windows Installer transform files (.mst) that customize your Reflection X Advantage installation.

To create and use a transform file

1. Start Installation Customization Tool and select **Create a new Setup customization file for the following product**.
2. Make the modifications you want for your customized install. Typical changes include:
   - Set the user interface level.
   - Specify which product features to install (page 72).
   - Configure file shortcuts (page 73).
   - Add companion installers (or other programs) to run with this installation. (page 74)
3. Apply the transform to your installation (page 75).

Select Features, Components, and Languages

You can select which features, components, and languages to install for your end users. In addition, you can make features available to users for a later installation or hide them from view.

To select features, components, and languages to install

1. From your administrative installation point, open the Installation Customization Tool from a shortcut (page 72) or by typing the following command line:
   `<path_to_setup>\setup.exe /admin`
2 From the Select Customization dialog box, do one of the following:
   - Select Create a new Setup customization file for the following product.
   - Select Open an existing Setup customization file or Companion installer and select an .mst file.

3 From the Installation Customization Tool navigation pane, select Set feature installation states, and for each feature, choose from the following states:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Feature will be installed on local hard drive</td>
<td>Add a feature to the installation. <strong>NOTE:</strong> Some features listed under a selected feature may not be included when you select to install the higher-level feature. The features that are included are the recommended defaults. If you select the higher level feature a second time, all sub-features will be included.</td>
</tr>
<tr>
<td>🔐 Feature will be installed when required</td>
<td>Advertise a feature.</td>
</tr>
<tr>
<td>✗ Feature will be unavailable</td>
<td>Leave a feature uninstalled. End users will still be able to select and install the item from the Windows Program and Features or the Add or Remove Programs control panel.</td>
</tr>
<tr>
<td>✗ Feature will be hidden from view</td>
<td>Leave a feature uninstalled and hidden. The feature will not appear in the Windows Program and Features or the Add or Remove Programs control panel.</td>
</tr>
</tbody>
</table>

**Configure Shortcuts**

You can change the attributes associated with the pre-defined Reflection X Advantage shortcuts. Also, you can configure shortcuts for files you’ve added to a custom install package.

**To configure shortcuts**

1 From your administrative installation point, open the Installation Customization Tool from a shortcut (page 72) or by typing the following command line:

   `<path_to_setup>\setup.exe /admin`

2 From the Select Customization dialog box, select any of the startup options. You can modify shortcuts in both transforms (.mst) and companion installers (.msi).

3 From the Installation Customization Tool navigation pane, choose Configure shortcuts.

4 Select the shortcut you want to configure, and then click Modify.
5 In the **Modify Shortcut** dialog box, enter the following settings:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Specify where you want the shortcut to reside | In the **Location** list, enter or select the folder.  
**NOTE:** To specify a folder location, you can select any of the predefined options in the drop-down list. The list of available locations depends on whether your installation is user-specific (the default) or for all users. For example **[PersonalFolder]** for user-specific installations, or **[ProgramFilesFolder]** for all user installations. You can edit these paths to include additional path information. For example: **[PersonalFolder]\Micro Focus\Reflection**. You can also manually enter full path information. For example **C:\demo\path**. The location you specify must exist on all target computers. |
| Name the shortcut | In the **Name** box, enter a descriptive name. |
| Add a tooltip to the shortcut | In the **Tooltip** box, enter descriptive text to describe the shortcut. |
| Pass command line arguments to the program | In the **Arguments** box, enter the command-line arguments. |
| Specify the size of the application window | In the **Run** list, select an initial size for the application window. |

**Add (Chain) Installations and Run Programs**

Reflection X Advantage makes it easy to "chain" installs. You can set up an install to run companion install packages automatically before or after the primary installation. You can also specify to run other scripts or programs.

**NOTE:** This method of chaining installations applies only to installs performed with **setup.exe**. It does not apply to installs that use the MSI command line method.

**To chain installations and programs**

1. From your administrative installation point, open the Installation Customization Tool from a shortcut (page 72) or by typing the following command line:

   `<path_to_setup>\setup.exe /admin`

2. Select **Create a new setup customization file for the following product**, and then click **OK**.

3. From the navigation pane, select **User Interface** and then select **Use this customization with interactive installs using setup.exe**.

4. From the navigation pane, select **Add installations and run programs**.

5. Click **Add**.

   The **Add/Modify Program Entry** dialog box opens.

6. In the **Target** list, enter or select the folder where the program **.exe** file or the **.msi** file resides, and then enter the executable to run. For example:

   `msiexec.exe`

7. Under **Arguments**, enter the command-line arguments to execute. For example:

   `/i my_installation.msi`
8 To specify when to run the program, select one of the following:
   • Run this program after base product has been installed
   • Run this program before the base product has been installed.

**NOTE:** For most cases, select Run this program after the base product has been installed. If you select Run this program before the base product has been installed and the program fails, Reflection X Advantage is not installed.

1 Repeat these steps to add other programs or .msi files.
2 To change the execution sequence, use the arrows next to Move in the lower-left area of the pane. To remove a program from the list, select it in the list and click Remove.

### Apply a Transform to Your Installation

If you have created a transform to customize how Reflection X Advantage is installed, you need to deploy the transform with the primary installation. (This is in contrast to companion installation packages, which can be chained with the primary installation or installed separately.) Any install started with setup.exe or with command-line installs can include a transform.

**To add the transform to installs started with setup.exe**

1 Start Installation Customization Tool and select Create a new Setup customization file for the following product.
2 Go to the User interface panel.
3 Select Use this customization with interactive installs using setup.exe.
   When you save your transform with this option selected, the Installation Customization Tool automatically updates the setup.ini file to apply the transform to the Reflection X Advantage installation by adding the following line to the [Setup] section:
   ```ini
   CustomTransform=<your_transform.mst>
   ```
   This modification to setup.ini means that any install using setup.exe (using either the interactive user interface or using setup.exe on a command line) will automatically apply this transform.
4 Save the transform to the default location (the folder that includes setup.exe).
   The transform can now be deployed to end users via the setup.exe file. (Users can run setup.exe directly or setup.exe can be called from a script or initiated from a command line.)

**NOTE:** If the setup.ini file already specifies the transform file you want to install (as noted in step 3 of the previous procedure) do not specify the transform on the command line.

**To add the transform to a setup.exe command-line install**

- From the command line, use the following syntax:
  ```cmd
  <path_to_setup>\setup.exe /install TRANSFORMS=<transform.mst>
  ```
Creating and Editing Companion Installer Packages

Create a companion installer package to install any files that are not automatically installed with Reflection X Advantage, including customized application settings. Companion installer packages are deployed independently of the installation. Therefore, you can upgrade the product without removing these support files. If you support several business units that require their own customized configuration files, you can create a companion installer package for each business unit.

Install the Companion Installer Package by adding it to your Reflection X Advantage install, or using any mechanism that supports Windows installer packages (.msi). Companion installer packages have no built-in user interface except a standard progress bar.

Basic steps for creating a companion package file

1. Configure and test the settings files you want to deploy to users.
2. Start Installation Customization Tool and select Create a new Companion installer.
3. Use the Specify package information panel to configure the program name you want to appear in the Windows Programs and Features control panel.
4. Use the Specify install locations panel to set the package either to install for all users (the default) or only the user who installs it. This setting can't be changed after you start adding files on the Add files pane.
5. Use the Add files pane to specify which files to include in the companion installer package, where to install them, and whether to include a shortcut for any of the added files.
6. If the application supports it, use the Modify user settings pane to customize user settings. The application must be installed on the administrative workstation.
   - Your modified user settings appear in the Location column and are automatically included in the companion installer package.
7. Add the companion installer package to your installation (page 78).

Editing an existing companion package file

1. Start Installation Customization Tool and select Open an existing Setup customization file or Companion installer.
2. Make your edits, then go to File > Save.
3. This opens the Increase Package Version dialog box.
   - Click Yes to increase the version number. This is required if you want to support upgrades of the package on computers that have installed an earlier version. (If you use Reflection Security Gateway (http://www.attachmate.com/Products/Terminal+Emulation/security/rsg/reflection-security-gateway.htm) to deploy companion packages, you can configure it to deploy a newer version automatically to end users.)
   - Click No to keep the same version number. Use this option if you are editing a companion package that is not yet installed on user computers; or if you do not need to upgrade existing computers.
4. Save the file using the same name or a different name. (The Windows Installer uses an internal GUID, not the filename to identify the package.)
Install Custom Templates with a Companion Installer Package

Templates are definition files that are installed to the Reflection X Advantage templates folder. Templates are imported for each user the first time the user runs X Manager or X Manager for Domains. Depending on how you create them, definition files may be imported silently or included in the Import Templates and Migrated Settings dialog box that displays on initial startup.

NOTE: If you run Reflection X Advantage in domain mode, you can create and share public settings definitions (page 56) instead of (or in addition to) creating and deploying custom templates. Unlike deployed templates, public definitions can be created and modified after X Manager for Domains has already been installed on user workstations.

To create a custom template

1. From X Manager or X Manager for Domains, click File > Export.
2. Select the definitions you want to include in the template.
3. Use the Template configuration options to configure how users will import this template.
   - If you want to enable users to select the template from a list, enter a Template name. This name shows up in the list of available templates in the Import Templates and Migrated Settings dialog box that displays on initial startup. (This name is not displayed if Automatically import template on first run is selected.)
   - To configure the template to be imported silently, select Automatically import template on first run.
4. Click Export. Enter a filename and click Save to complete the export process.

You can use the Installation Customization Tool to create a companion file to install this template on Windows systems.

To create a companion package to install one or more custom templates

1. Create an administrative installation image (page 70).
2. From your administrative installation point, open the Installation Customization Tool from a shortcut (page 72) or by typing the following command line:
   <path_to_setup>\setup.exe /admin
3. From the Select Customization dialog box, select Create a new Companion installer and then click OK.
4. From the navigation pane, click Specify package information. Use this panel to specify the information your package will use in the Windows Programs and Features (or Add or Remove Programs) list.
5. From the navigation pane, click Specify install locations. On this panel, select Installs to all users of a machine. (The installation locations available change based on this setting and you need to install this template to the program files folder.)
6. From the navigation pane, click Add Files.
7. Under Add files to at the bottom of the panel, specify the templates subfolder in your program installation location; for example [ProgramFilesFolder]\Reflection\templates. (You can manually edit the pre-configured item [ProgramFilesFolder]\My Files.)
8. Click Add. Browse to locate your template file and click Open.
9 Choose File > Save As and enter a name for your installation package (for example RXATemplates.msi).

10 (Optional) Chain this installer (page 78) to have it run automatically after installations done using setup.exe.

Add a Companion Installer to your Installation

After you've created a companion package (.msi) with ACT, use this procedure to add it to your product installation. When end users run Setup.exe, any added packages are automatically installed after the primary installation is complete.

To add a companion installer package to your installation

1 From your administrative installation point, open the Installation Customization Tool from a shortcut (page 72) or by typing the following command line:

```
<path_to_setup>\setup.exe /admin
```

2 Select Create a new setup customization file for the following product, and then click OK.

3 From the navigation pane, select User Interface and then select Use this customization with interactive installs using setup.exe.

4 From the navigation pane, click Add installation and run programs.

5 Click Add.

The Add/Modify Program Entry dialog box opens.

6 In the Target list, browse to select the companion installer file (.msi).

7 Select Run this program after the base product has been installed.

8 Click OK.

9 Click File > Save As to save your transform.

The Installation Customization Tool automatically updates the Setup.ini file, adding a [RunPrograms] section with instructions for installing your companion installer package.

Deploying Sessions with the Administrative WebStation

Management and Security Server (formerly Reflection Security Gateway) is a Micro Focus product that supports centralized management of Reflection sessions. If you have installed Management and Security Server, you can use the Reflection Administrative WebStation to administer Reflection X Advantage sessions. This allows users to connect through the Management and Security Server Security Proxy server, which provides SSL/TLS encryption to the proxy. Using Management and Security Server also enables you to restrict the visibility of your hosts over the network and to limit host access to authorized users and members of LDAP groups.

In this Section

- “Configure Sessions using the Administrative WebStation” on page 79
- “Setting up a Session using the Security Proxy” on page 79
- “Managing Upgrades for WebStation Sessions” on page 81
- “Administrative WebStation Mode” on page 81
- “WebStation User Mode” on page 81
Configure Sessions using the Administrative WebStation

Before you begin

- Install X Manager (standalone) on administrator and user computers. These must be Windows systems.
- Install Management and Security Server on a server. (This installs two servers, the Reflection Management Server and the Reflection Security Proxy.) Make sure you have administrative credentials to log onto the Reflection Management Server.

To deploy a session with the Administrative WebStation

1. In a Web browser, launch Management and Security Server and log on as an administrator. Click Administrative WebStation.
2. In the Administrative WebStation navigation pane, under Activities select Session Manager.
3. In the Session Manager, click Add to open the Add New Session page.
4. In the Add New Session page, select X Advantage, enter a session name, and click Continue.
5. By default Start X Manager in notification area of taskbar is enabled. With this option X clients are launched on user desktops and X Manager runs in the background on the user's machine. Users see only the clients that are configured to open at startup.
6. (Optional) In X Manager Preferences, make your selection for FIPS mode. Select this checkbox to enable FIPS, which enforces the United States government Federal Information Processing Standard (FIPS) 140-2 for this session.
7. (Optional) Add any comments that you want to have available for review in the Administrative WebStation.
8. Click Launch. This launches X Manager in “Administrative WebStation Mode” on page 81.
9. Configure one or more X clients that you wish to make available to your end users.
10. Test your connection. In response to the Host Key Unknown prompt, click Always. This adds the key to the known hosts list in the configuration you save to the web server so users won't see the prompt.

**NOTE:** The option to save a host key by selecting Always is not available for sessions running in WebStation User Mode.

11. Go to File > Exit. Click Save/Exit to close your session and save the configuration to the Management and Security Server Administrative WebStation.
12. From the Management and Security Server Administrative WebStation, map access for your users.

Setting up a Session using the Security Proxy

The Management and Security Server Security Proxy server provides SSL/TLS encryption to the proxy.

Before you begin

- Install X Manager (standalone) on administrator and user computers. These must be Windows systems.
• Install Management and Security Server on a Windows or UNIX server. (This installs two servers, the Reflection Management Server and the Reflection Security Proxy.) Make sure you have administrative credentials to log onto the Reflection Management Server.

• Install PKI Services Manager on a Windows or UNIX server. See “Using PKI Services Manager with Reflection X Advantage” on page 102 for information about installing and configuring this tool.

**Configure PKI Services Manager to validate the Management and Security Server Security Proxy certificate**

The method you use depends on how the Security Proxy is configured:

• If you’ve obtained a certificate for the Security Proxy from a Certification Authority (CA), add the CA certificate to the PKI Services Manager trusted root store.

• If you’re using the proxy’s default self-signed certificate, add this certificate to the PKI Services Manager trusted root store. To obtain a copy of the default certificate, from the server running Management and Security Server start the Security Proxy Wizard, and go to Security Proxy Certificates > Export.

Note: PKI Services Manager supports the ability to map which entities can authenticate using certificates. This is not used when validating the Security Proxy certificate, so you do not need to configure identity mapping.

**To deploy a session with the Administrative WebStation**

1. Log into the **Administrative WebStation** and select **Session Manager**.
2. In the Session Manager, click **Add** to open the **Add New Session** page. Select **X Advantage**, enter a session name, and click **Continue**.
3. (Optional) On the **Configure a Windows-Based Reflection Session** page modify any of the optional settings.
4. Click **Launch**. This launches X Manager in “Administrative WebStation Mode” on page 81.
5. Configure your X client settings.
6. For each configured client, click **Advanced** to open the **Advanced Secure Shell Settings** dialog box.
   - On the **Proxy tab** select **Use Reflection security proxy**.
   - Under **Security proxy server**, select your proxy server and port from the drop-down lists.
   - Click **Close**.
7. Go to **Tools > Secure Shell Host Keys > PKI Configuration**.
   - For **PKI server**, enter the name of the computer running PKI Services Manager.
   - Click **Download key** and click **Yes** to accept the key.
8. Test your connection. In response to the **Host Key Unknown** prompt, click **Always**. This adds the key to the known hosts lists in the configuration you save to the web server so users won’t see the prompt.

   **NOTE:** The option to save a host key by selecting **Always** is not available for sessions running in WebStation User Mode.

9. Go to **File > Exit**. Click **Save/Exit** to close your session and save the configuration to the Management and Security Server Administrative WebStation.
Managing Upgrades for WebStation Sessions

If you configured WebStation sessions for use with an older version of Reflection X Advantage, users can upgrade Reflection X Advantage and continue to use their existing sessions. When users launch sessions in WebStation User mode, session settings are migrated automatically to run on the newer version each time the users connect.

When you launch sessions in Administrative WebStation mode after upgrading Reflection X Advantage on your workstation, session settings are migrated automatically and this migration becomes permanent when you click Save/Exit. Don't make this change until all user workstations have been upgraded. Settings that have been migrated to the new version will no longer work for users who are still running an older version.

Administrative WebStation Mode

When you launch Reflection X Advantage from the Management and Security Server Administrative WebStation, the title bar displays X Manager- Administrative WebStation Mode. This mode provides additional security settings. These are configurable via the Proxy tab, which is only available in this mode. (To view the Proxy tab when running in WebStation mode, set Connection method to Secure Shell, and click Advanced.)

When X Manager is launched in Administrative Webstation mode, there are limitations on what you can do:

- Only one session is available. You can modify the settings for this session, but you cannot add additional sessions.
- One default X client definition is available. You can edit this client and create additional clients. You can also create and edit launch groups.
- XDMCP Connections are not supported.
- SSH is the only connection method available for clients.
- Changes you make to the session, client, and launch group definitions are not saved until you exit X Manager.
- When you close X Manager, you will be prompted to save your settings. Click File > Exit, and then click Save/Exit on the Save Settings dialog box. This saves your settings on the Management and Security Server Management Server. If you have just created the session, you will be prompted in the Administrative WebStation to map the session so that it is available to users.
- You cannot modify FIPS mode. (The setting for FIPS is configured using the Session Manager in the Administrative WebStation.)

WebStation User Mode

If you open X Manager after launching a session from the Links list of a Management and Security Server management server, the title bar displays X Manager- WebStation User Mode.

- When you launch an X Manager session in this mode, you have access to the X clients or launch groups created by the administrator.
• Depending on how the session has been configured by the administrator, clients may start automatically or be started as needed. If X Manager runs in the notification area of the taskbar (the default), you must select the Show X Manager taskbar option to start a client manually.

• You can add clients using X Manager, but they cannot be saved as part of the session, and will not be available the next time the session is launched from the Links list. You can, however, export the clients for later use.

Save Settings (Administrative WebStation Mode)

When you launch Reflection X Advantage from the Management and Security Server Administrative WebStation, you open X Manager in Administrative WebStation mode. You can add and edit X clients and launch groups, and edit the session definition. Use this dialog box to save these changes to the Management and Security Server Management Server.

Save/Exit

Any changes you have made using X Manager are saved to your Management and Security Server session. After you configure access in the Administrative WebStation, the session is available to users.

Discard

Any changes you have made will be discarded.

Cancel

Return to X Manager.

Discard Settings (WebStation User Mode)

When you launch a Reflection X Advantage session from the Links list of a Management and Security Server management server, the clients created for this session by the administrator are available to you. You can add clients if you open X Manager in user mode, but they will not be available the next time the session is launched from the Links list. You can export the clients if you wish to retain them for import when you open the session again.

Click Discard to exit X Manager. Any changes you have made will not be saved. Click Cancel to return to the session without exiting, then select File > Export if you wish to save your changes by exporting them.
Reflection X Advantage Data Files

Reflection X Advantage stores settings in a database file. Settings are saved automatically while you work. Administrators are not required to perform any direct maintenance for this database. However, it may be appropriate to include this file in your site’s general backup or archiving procedures. Backup procedures should include both the database folder (db) and the configuration folder (conf). The location of these folders depends on your operating system, whether you run the in standalone or domain mode, and which version you first installed.

- Standalone X Manager Database files (page 83)
- Domain database files (page 84)
- Reflection X Service configuration files (page 84)
- Data location information for upgrading users (page 84)

Standalone X Manager Database files

The database files for the standalone X Manager are stored in the following user-specific location:

On Windows systems:
- The database is located in the user’s personal Documents folder:
  \%UserProfile\%\Documents\Micro Focus\Reflection\db\<version>
  For example:
  C:\Users\Username\Documents\Micro Focus\Reflection\db\<version>

On UNIX systems:
- The database is in the user’s home folder:
  $HOME/.microfocus/reflection/db
Domain database files

The database files for a Reflection X Advantage domain are located on the computer that is running the domain controller in the following location:

On Windows systems:

The domain database is located in the Windows All Users Profile folder. The default location depends on your version of Windows. For example:

C:\ProgramData\.attachmate\rx\db\<version>

-or-

C:\Documents and Settings\All Users\.attachmate\rx\db\<version>

On UNIX systems:

The domain database is in the following location:

/opt/rxadvantage/rx/db

Reflection X Service configuration files

The following domain mode configuration files are used by the Reflection X Service and stored in the conf directory. On Windows systems, conf is located in the Windows All Users profile folder (%AllUsersProfile%\.attachmate\rx\conf). On UNIX, conf is a subdirectory of the product installation directory.

**NOTE:** These files are should not be edited manually.

- **domains.xml**  
  Configuration for domain controller. This file is created when you install the Domain Controller feature.

- **domain-nodes.xml**  
  Configuration for domain nodes. This file is created and maintained using the rxsconfig command line utility.

- **host-nodes.xml**  
  Configuration for remote session services. This file is created when you install the Remote Session Services feature.

The conf folder also stores private keys and certificates that are used for authenticating distributed session components.

Data location information for upgrading users

Reflection X Advantage stores user data (including database files for the standalone X Manager and user log files) in a different location than that used prior to version 5.1. The data location used for the domain database has not changed.

If you install without uninstalling your prior version, Reflection X Advantage continues to use your existing data files in their original location.

If you uninstall an earlier version (prior to 5.1) before installing, the new installation uses new default settings in the new location. To restore your customized settings, you can manually copy your prior version data to the new location as follows:

1. Locate your data files:
   - Windows: %UserProfile%\.attachmate\rx\domains.xml
   - Unix: $HOME/.attachmate/rx
2 Copy each of the subdirectories under `rx` to the new location:

**Windows:** `%UserProfile%\Documents\Micro Focus\Reflection\`

**NOTE:** This Windows folder is used by other Micro Focus applications. Do not overwrite or delete other content in this folder.

**UNIX:** `$/HOME/.microfocus/reflection/

**NOTE:** The user data location is specified in a file called `install.properties` located in the Reflection X Advantage program folder. To confirm the location currently in use you can view the contents of this file. Do not edit this file; its contents are overwritten each time you apply a hotfix or upgrade.

## Ports used by Reflection X Advantage

Reflection X Advantage uses the ports summarized below. Depending on your Reflection X Advantage configuration, you may need to configure a firewall to allow a port exception for one or more of these ports.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default port</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Manager</td>
<td>6000 (If you specify a fixed display number, the port used is 6000 + display number)</td>
</tr>
<tr>
<td>Domain Node</td>
<td>22001 (if you have more than one domain node configured, each must have a separate port)</td>
</tr>
<tr>
<td>Domain Controller</td>
<td>22000 (default)</td>
</tr>
<tr>
<td>Remote Session Services</td>
<td>21999 (default)</td>
</tr>
</tbody>
</table>

Note: The domain controller, domain nodes, and remote session services are processes of the Reflection X Service. The ports listed above are defaults for these processes. You can run the `rxsconfig` (page 99) command line utility to determine which ports are actually configured on your system. The following command lists all configured Reflection X Service processes sorted by port number:

```
rxsconfig list
```

## Feature Guide for Upgrading from Reflection X version 13 or 14

If you are upgrading from legacy Reflection X products (version 13 or 14), use the following tables to find features in Reflection X Advantage.

### Client Settings

Legacy Reflection X client files (*.rcx) are migrated automatically to Reflection X Advantage X Clients and XDMCP Connections the first time you run Reflection X Advantage. See Upgrading from Legacy Reflection X (page 17).
### Server Settings

Legacy Reflection X server settings are stored in the Windows registry. These settings are migrated automatically to Reflection X Advantage session definitions (page 123) the first time you run Reflection X Advantage. Server settings are migrated to a session definition called "config." (If you created any new X Server Instances, these settings are migrated using the name you provided.)

<table>
<thead>
<tr>
<th>Reflection X version 13 or 14</th>
<th>Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client file (.rxc)</td>
<td>All settings are saved to the Reflection X Advantage database (page 83)</td>
</tr>
<tr>
<td>X Client connection settings such as Method, Host name, User name, Password, and Command</td>
<td>Client definition.</td>
</tr>
<tr>
<td>Advanced client connection settings</td>
<td>Client definition &gt; select a Connection method &gt; click Advanced.</td>
</tr>
<tr>
<td>Secure Shell authentication and encryption</td>
<td>Client definition &gt; Connection method = Secure Shell &gt; Advanced button</td>
</tr>
<tr>
<td>Secure Shell key management</td>
<td>Tools &gt; Secure Shell User Keys, Tools &gt; Secure Shell Host Keys</td>
</tr>
<tr>
<td>XDMCP connection settings</td>
<td>XDMCP Connection definition</td>
</tr>
</tbody>
</table>

### Window Manager

- **Window mode**
  - Microsoft Windows desktop or X terminal desktop

### Display

- **X display number**
  - Display > Require display number (By default, Reflection X Advantage dynamically chooses a display number based on available ports.)

### X Screen

- **Number of X screens**
  - Specify total number
- **Virtual width pixels**
- **Virtual height pixels**
- **MM width dimension**
- **MM height dimension**
- **Place it on monitor(s)**
  - Display Click plus (+) in the title bar of the Screen Definition table to add a screen.
<table>
<thead>
<tr>
<th>Reflection X version 13 or 14</th>
<th>Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full size (no title bar)</td>
<td>Display &gt; Screen Definition table &gt; Hide Title Bar</td>
</tr>
<tr>
<td><strong>Server</strong></td>
<td></td>
</tr>
<tr>
<td>Backing store</td>
<td>Display &gt; Backing store</td>
</tr>
<tr>
<td>Save unders</td>
<td></td>
</tr>
<tr>
<td>Enable X11R3 bug compatibility</td>
<td>Display &gt; Permit X11R3 bugs</td>
</tr>
<tr>
<td>Exit when last client closed</td>
<td>General &gt; On last client &gt; Stop session and exit X Manager</td>
</tr>
<tr>
<td>Confirm close when clients are connected</td>
<td>File &gt; Preferences &gt; On exiting X Manager &gt; Prompt</td>
</tr>
<tr>
<td>Extensions</td>
<td>Extensions</td>
</tr>
<tr>
<td>Log file</td>
<td>See “Log Files” on page 112</td>
</tr>
<tr>
<td>Log X protocol errors</td>
<td>Logging &gt; Log X protocol errors</td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td></td>
</tr>
<tr>
<td>Font path</td>
<td>Fonts &gt; Server font path</td>
</tr>
<tr>
<td>Allow font scaling</td>
<td>Fonts &gt; Allow font scaling</td>
</tr>
<tr>
<td>Log font activity</td>
<td>Logging &gt; Log font activity</td>
</tr>
<tr>
<td>Try font server on client host</td>
<td>Fonts &gt; Use font server on X client host</td>
</tr>
<tr>
<td>Allow font substitution</td>
<td>Fonts &gt; Allow font substitutions</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td></td>
</tr>
<tr>
<td>Default visual type</td>
<td>Display&gt; Screen Definition table &gt; Default Visual Type</td>
</tr>
<tr>
<td>Colormap preallocation</td>
<td>Display &gt; Screen Definition table &gt; Black and White Pixels and Allocate B&amp;W in Client Maps</td>
</tr>
<tr>
<td>Set maximum colormaps to 1</td>
<td>Display &gt; Set maximum colormaps to 1</td>
</tr>
<tr>
<td>Advertise linear visuals</td>
<td>Display &gt; Screen Definition table &gt; Linear Visuals</td>
</tr>
<tr>
<td>Advertise single depth visuals</td>
<td>Display &gt; Screen Definition table &gt; Single Depth Visuals</td>
</tr>
<tr>
<td>RGB Color file</td>
<td>Display &gt; Color scheme &gt; Edit &gt; Import</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
</tr>
<tr>
<td>Host-based security</td>
<td>Security &gt; Host-based authorization</td>
</tr>
<tr>
<td>Host access security file</td>
<td>Security &gt; Authorized Hosts (this option is visible when Host-based authorization is enabled.)</td>
</tr>
<tr>
<td>User-based security</td>
<td>Security &gt; User-based authorization</td>
</tr>
</tbody>
</table>
### File Access Restrictions for Files With Sensitive Information

Some files used by Reflection X Advantage contain information that might pose a security risk if acquired or modified by a malicious user. When files with sensitive data are created, they are given file permissions that minimize this risk. You should not change these default permissions, as doing so creates an increased security risk. Depending on how you install and configure Reflection X Advantage, you may have files that contain the following sensitive information:

- Private keys used to authenticate a user to a remote X client host. Depending on your configuration, these files may be on your file system or stored within the Reflection X Advantage database.

<table>
<thead>
<tr>
<th>Reflection X version 13 or 14</th>
<th>Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>User authorization Duration</td>
<td>Security &gt; Authorization timeout (this option is visible when User-based authorization is enabled.)</td>
</tr>
<tr>
<td><strong>Network</strong></td>
<td></td>
</tr>
<tr>
<td>Disable remote TCP/IP connections</td>
<td>Security &gt; Allow remote IP connections</td>
</tr>
<tr>
<td>Enable keep alives</td>
<td>Advanced &gt; Perform IP keep alives</td>
</tr>
<tr>
<td>Log server network activity</td>
<td>Logging &gt; Log network activity</td>
</tr>
<tr>
<td><strong>Keyboard settings</strong></td>
<td></td>
</tr>
<tr>
<td>Backspace key sends</td>
<td>Keyboard &gt; Backspace sends</td>
</tr>
<tr>
<td>Allow clients to remap keyboard</td>
<td>Keyboard &gt; Permit X clients to remap the keyboard</td>
</tr>
<tr>
<td>Host keyboard</td>
<td>Keyboard &gt; Keyboard Map (select a predefined keyboard)</td>
</tr>
<tr>
<td>Keyboard map</td>
<td>Keyboard &gt; Keyboard Map &gt; Edit (To create a custom keyboard map, start by cloning the default keyboard map.)</td>
</tr>
<tr>
<td><strong>Mouse</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Mouse wheel scroll</td>
<td>Mouse &gt; Mouse wheel scroll &gt; Disable scroll wheel</td>
</tr>
<tr>
<td>Mouse wheel &gt; Customize</td>
<td>Mouse &gt; Mouse wheel scroll</td>
</tr>
<tr>
<td>Enable middle button emulation</td>
<td>Mouse &gt; Enable middle button emulation</td>
</tr>
<tr>
<td>Middle button detection speed</td>
<td>Mouse &gt; Middle button detection speed</td>
</tr>
<tr>
<td><strong>Clipboard</strong></td>
<td></td>
</tr>
<tr>
<td>Selection bound to clipboard</td>
<td>Display &gt; Selection bound to clipboard</td>
</tr>
<tr>
<td><strong>DBCS</strong></td>
<td></td>
</tr>
<tr>
<td>Input Method</td>
<td>Keyboard &gt; Native IME Support</td>
</tr>
</tbody>
</table>
• Saved passwords. Passwords are saved to the Reflection X Advantage database. Passwords in the database are not encrypted. The security of this information is maintained by the access restrictions on the database files.

• Reflection X Service settings identifying the nodes in a distributed Reflection X Advantage configuration, and the ports used by those nodes.

• Private keys used by Reflection X Advantage to authenticate programs and users during session sharing and use of remote session services.

Log File Warnings

When a Reflection X Advantage program or service uses a file that should be configured for restricted access and the file permissions have been modified in a way that presents a potential security risk, the program or service continues to use that file, but also logs a warning to the appropriate log file. See Logging (page 112) for information about where to locate log files.

For example, the following \texttt{xmanager.log} entry shows that the private key demokey, which was used to authenticate to an X client host, has insufficient access restrictions:

\begin{verbatim}
[ WARN]: Permissions incorrect for C:\Users\Joe\Documents\demokey. The permissions should be set to only allow Joe access.
\end{verbatim}

Files with Access Restrictions

The files in the table below are created using the recommended access restrictions shown in the table. These permission settings should not be modified.

<table>
<thead>
<tr>
<th>Files</th>
<th>Location</th>
<th>Access Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Shell user keys</td>
<td>User-defined. Note: It is recommended that you put user keys in a directory that is owned by the user; however, placing keys in a shared location does not generate a warning as long as the keys themselves use the default access restrictions.</td>
<td>Readable and writable only by the user.</td>
</tr>
<tr>
<td>Stand-alone X Manager database (on the computer running X Manager)</td>
<td>\textbf{Windows:} %UserProfile%\Documents\Micro Focus\Reflection\db\</td>
<td>Readable and writable only by the user</td>
</tr>
<tr>
<td></td>
<td>\textbf{UNIX:} $HOME/.microfocus/reflection/db/</td>
<td></td>
</tr>
<tr>
<td>Domain database (on the computer running the Domain Controller)</td>
<td>\textbf{Windows:} %AllUsersProfile%.attachmate\rx\db</td>
<td>Readable and writable only by administrator</td>
</tr>
<tr>
<td></td>
<td>\textbf{UNIX:} /opt/rxadvantage/rx/db</td>
<td></td>
</tr>
<tr>
<td>Reflection X Service configuration files:</td>
<td>\textbf{Windows:} %AllUsersProfile%.attachmate\rx\conf</td>
<td>Writable only by administrator</td>
</tr>
<tr>
<td>domains.xml</td>
<td>\textbf{UNIX:} &lt;rxa_installation_directory&gt;/conf</td>
<td></td>
</tr>
<tr>
<td>domain-nodes.xml</td>
<td></td>
<td></td>
</tr>
<tr>
<td>host-nodes.xml</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Changing the JRE

By default Reflection X Advantage installs and uses a private Java Runtime Environment (JRE). This installed JRE is correctly configured to fully support all Reflection X Advantage features. It is also possible to configure Reflection X Advantage running on Windows to use a different JRE. The information that follows is provided for administrators who want to configure Reflection X Advantage to use a separately installed JRE.

**NOTE**

- Micro Focus will supply updated Java installation packages as needed to provide customers with Java security updates. These packages can be downloaded and applied independently of updates to the main Reflection X Advantage package. If you update the JRE using a Micro Focus Java package, your JRE will be correctly configured automatically. The information below is not required for these installations; it is provided for users who want to update their JRE without using the Micro Focus installer.

- If you want to use the private JRE installed by the Micro Focus Java package, you must select the **Java Runtime Environment (JRE)** feature in the installation feature tree. In addition to running the associated Java installer, this feature modifies settings in the Windows registry that configure Reflection X Advantage to use the private JRE.

**JRE Search**

Reflection X Advantage running on Windows uses the following search order to locate a JRE on your system.

- The private JRE installed with Reflection X Advantage when you include the feature "Java Runtime Environment (JRE)."
- The path specified in an environment variable called RXA_JRE_HOME. See instructions below for configuring this variable.
- A system JRE that has already been installed on your system using the Oracle installer. (Note that the default JRE installed from a browser does not include unlimited strength cryptography files and is for a "client" environment, not a "server" environment. Refer to the procedures that follow to configure a JRE that resolves these problems.)

<table>
<thead>
<tr>
<th>Files</th>
<th>Location</th>
<th>Access Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflection X Service identity files:</td>
<td>Windows: %AllUsersProfile%.attachmate\rx\identity</td>
<td>Readable and writable only by administrator</td>
</tr>
<tr>
<td></td>
<td>UNIX: &lt;rxa_installation_directory&gt;/identity</td>
<td></td>
</tr>
<tr>
<td>X Manager application and user private keys (not user-generated; these are used by X Manager for session sharing):</td>
<td>Windows: %UserProfile\Documents\Micro Focus\Reflection\identity</td>
<td>Readable and writable only by the user</td>
</tr>
<tr>
<td></td>
<td>UNIX: $HOME/.microfocus/reflection/identity</td>
<td></td>
</tr>
</tbody>
</table>
If no JRE is available, the Reflection X Advantage applications will not run and the Reflection X Advantage application log files (page 112) will include a message saying that the application failed to start because the JVM is not available. (This message also appears as a warning in the Windows Event log.)

The Reflection X Advantage application logs (page 112) provide information about which JRE is used. Search for "JVM_EXE." For example:

INFO - [ INFO]: JVM_EXE is: C:\Program Files\Common Files\Micro Focus\JDK\Java7\jre\bin\java.exe

**JRE Error and Warning Messages in the Log Files**

If a JRE is found, Reflection X Advantage will check to see if the JRE meets all the conditions of the private JRE. (page 112)

If you run in domain mode, the JRE must be configured for unlimited strength cryptography.

- A fatal error is written to the rxs.log (page 112) when you attempt to start the Reflection X Service using a JRE that is not configured for unlimited strength cryptography. To resolve this, see instructions below to apply Oracle's Unlimited Strength Jurisdiction Policy Files to your JRE.

Warnings are written to the application log files (page 112) if:

- The running JRE is older than the version shipping with this build of Reflection X Advantage.
- The running JRE is for a "client" environment, not a "server" environment. To resolve this, see the instructions below for installing a Java Development Kit (JDK) from the Oracle site.
- You run X Manager using a JRE that is not configured for unlimited strength cryptography. Neither export-controlled crypto algorithms nor FIPS mode will be available. To resolve this, see instructions below to apply Oracle's Unlimited Strength Jurisdiction Policy Files to your JRE.

**Installing and Configuring a JRE**

Use the following procedures to configure Reflection X Advantage running on Windows to use a non-default JRE.

The default JRE installed from a browser is for a "client" environment, not a "server" environment. Reflection X Advantage requires the server JRE for full functionality. You can download and install this from the Oracle website.

**Step 1: Install a Java JDK from the Oracle site**


   Download and install the JRE using either the JDK download (which installs the server JRE) or the Server JRE download.

   Download the most recent update of the major version Java that was included with Reflection X Advantage. For version 16.1, download the most recent Java 8 update.

2. After installing the JRE, run the following command to confirm that the JRE version reported is the version you downloaded:

   ```
   /<java-path>/bin/java -version
   ```

   For example:

   ```
   # /jdk/jdk1.8.0_**nn**/jre/bin/java -version
   java version "1.8.0_**nn**"
   Java(TM) SE Runtime Environment (build 1.8.0_**nn**-b01)
   ```
The next procedure configures an environment variable that directs Reflection X Advantage applications to use the correct JRE.

**Step 2: Configure the RXA_JRE_HOME variable**

1. Open Windows System Properties (Start > Control Panel > System > Advanced system settings).
2. From the Advanced tab click Environment Variables.
3. Under System variables, click New, define a new variable as follows, then click OK.

   **Variable name**  RXA_JRE_HOME  
   **Variable value**  The location of the Java JRE. Point to the JRE located in the JDK installation. This is the JRE configured for a server environment. For example:  
   
   C:\Program Files\Java\jdk1.8.0_<nn>\jre

4. Click OK to close the open dialog boxes.

The next procedure applies the Java Unlimited Strength Jurisdiction Policy Files. This step is recommended for all installations. It is required to run the Reflection X Advantage domain services. It is also required if you enable FIPS Mode.

**Step 3: Apply the Unlimited Strength Jurisdiction Policy Files to your JRE**

**NOTE:** Each time you upgrade your JRE, you need to apply the unlimited strength policy files to the new JRE.

2. Download the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files.
3. Unzip the downloaded file and locate the following two policy files.

   - local_policy.jar
   - US_export_policy.jar

4. Copy the policy files to `<java home>\jre\lib\security`, replacing the existing files in your JRE folder. For example:

   C:\Program Files\Java\jdk1.8.0_<nn>\jre\lib\security

**Uninstall the default JRE**

If you're setting up an alternate JRE and have already installed the default JRE with Reflection, you must uninstall the default JRE. To do this, use the following procedure:

**To uninstall the default Micro Focus JRE**

1. To open the Programs and Features control panel go to Start > Control Panel > Programs and Features. (On older Windows systems, this Control Panel is called Add or Remove Programs.)
2. Select the entry with your Reflection product name — not the Java entry — and click Change.
3. On the Feature Selection tab, click the icon to the left of Java Runtime Environment (JRE) and select Feature will be Unavailable.
4. Click Continue.
Upgrade Digital Certificates used by Reflection X Advantage Domains

Digital certificates are used in domain mode for authenticating domain nodes and the domain controller. Starting with version 5.0, these certificates use a more secure signing algorithm. If you have upgraded from an earlier version, the domain continues to use your prior version certificates and logs the following warning message in the rxs.log (page 112) file:

[WARN]: The domain root certificate generated by an earlier version of Reflection X Advantage is signed using the SHA1withRSA algorithm. Current versions create certificates signed using the more secure SHA-256 RSA algorithm. You can upgrade certificates by removing existing certificates.

If you run in FIPS mode, you must upgrade your domain to use the more secure certificates before you can log into the domain. Until you upgrade the certificates, attempts to log into the domain will fail with the message "Authentication with the domain failed." The domain.log file will include a warning entry saying that the connection was rejected because the domain is set for FIPS mode, but has a public key of insufficient length. Use the procedure below to resolve this issue.

To upgrade your domain to use SHA-256 RSA certificates

1. Stop the Micro Focus Reflection X Service on the domain controller and on any domain nodes. (page 42)
2. Locate the Reflection X Service configuration files (page 83) on the domain controller and all domain nodes. The certificates are located in the conf subfolder. Delete all certificates (*.cer) and any associated private key files (same base file name as a certificate with no file extension) from the controller and nodes.

   NOTE: Do not delete the *.xml files in the conf folder.
3. Restart the service on the domain controller and nodes. This step generates new certificates and keys to replace the ones you deleted.
4. Log onto X Administrative Console and delete all node definitions. (These will all have a red slash through them indicating that they are not available.)
5. On each node, use rxsconfig to leave (page 44) the domain. You should see a message like the following:

   Unable to remove node 0.0.0.0:22001 from domain domainname. Proceeding with local deletion.
   Deleted node 0.0.0.0:22001 for domain domainname

6. Use rxsconfig to rejoin (page 43) each node to the domain.

Command Line Utilities

rxmgr Command Line - Standalone X Manager

You can run X Manager and start clients and sessions from a command line using the following syntax:

```bash
rxmgr [-client client_name] [-xdmcp xdmcp_definition | [direct|indirect|broadcast,[host_address],[timeout],[onLastClient]][-launchGroup launchGroup_Name] [-session session_name][minimize] [-trayOnly] [-noUI] [-execOnly] [-import filename_or_URL][-noStart] [-noMigrate] [-?]```

Administrator Reference 93
Examples

The following example starts the xterm client and the session associated with it. In this example X Manager will run minimized.

rxmgr -client xterm -minimize

The following examples show two ways to start multiple clients (and any sessions associated with these clients): you can include all the clients on the command line or use a saved launch group definition. Quotation marks are required around the client and launch group definition names in these examples because the names include spaces.

rxmgr -client "Client 1" -client "Client 2" -client "Client 3"
-or-
rxmgr -launchGroup "Work Group"

The following example starts an XDMCP connection to "Myhost" without using an existing definition and without showing the X Manager for Domains window. When the user logs out of the XDMCP session, the session will stop and X Manager will exit.

rxmgr -xdmcp direct,Myhost,,Exit -noUI

The following example launches X Manager with limited functionality. The user can launch existing definitions, but not add or modify definitions:

rxmgr -execOnly

Options

The command line options are all optional. Options are case-insensitive. Use quotation marks around paths and definition names that include spaces.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-client client_name</td>
<td>Specify a client definition to start. To start multiple clients, use multiple client parameters (or configure a launch group.)</td>
</tr>
<tr>
<td>-xdmcp xdmcp_definition</td>
<td>Start an XDMCP connection using an existing definition name.</td>
</tr>
<tr>
<td>-or-</td>
<td>-or-</td>
</tr>
</tbody>
</table>
| -xdmcp direct\|indirect\|broadcast,\[host_address\],\[timeout\],\[onLastClient\]  | Specify XDMCP connection information directly on the command line. Specify host address using a DNS name or IP address. If the host address is omitted, the user is prompted. Specify timeout in seconds; the default is 15. Valid values for onLastClient are Nothing (or N), Reset (or R), Stop (or S), or Exit (or E). The default is Reset.
|                            | Do not use spaces after the commas in this option, and include a comma as placeholder for any option you don't need to specify. For example: |
|                            | -xdmcp direct,myhost,,E                                                    |
| -launchGroup group_name    | Launch all X clients and/or XDMCP connections in the specified launch group definition. |
| -session session_name     | Specify a session definition to start. To start multiple sessions, use multiple session parameters. |
You can run X Manager for Domains and start clients and sessions from a command line using the following syntax:

```
rxmgrdomains [-domain domain_name] [-user user_name] [-password password][-client client_name] [-xdmcp xdmcp_definition | [direct|indirect|broadcast,[host_address],[timeout],[onLastClient]]] [-launchGroup launchGroup_Name] [-session session_name] [-owner owner_name][-minimize] [-trayOnly] [-noUI] [-execOnly] [-noMigrate] [-?] 
```

### Option Description

- **-minimize**
  Start in a minimized state. This option is ignored if it’s not supported by the operating system. This option is ignored if **trayOnly** is also specified.

- **-trayOnly**
  Start with a tray icon but without opening the X Manager window. Note: When a session is started with this option, you can use either the tray icon or the Start menu to open the X Manager window.

- **-noUI**
  Start with an icon in the tray area and without allowing the user to open the X Manager window. With this option, the Open X Manager option is disabled from the tray icon; the Exit and Help Topics options remain available. Note: When a session is started with this option, it is not possible to open the X Manager window from the Start menu until the session is closed and you stop X Manager using the tray icon’s Exit option.

- **-execOnly**
  Start with the user interface restricted to a list of definitions (X Clients, XDMCP Connections, Launch Groups, Sessions) and the basic controls to start, stop, leave and join. Items that allow creating new definitions, deleting definitions, or accessing other features (such as keyboard maps and color maps) related to definitions are not available.

- **-import filename_or_URL**
  X Manager imports the specified Reflection X Advantage definition file before starting the user interface. You can specify a file path or a URL (for example “http://localhost/settings.rxd”). Quotation marks are required if the file or path includes spaces.

- **-noStart**
  X Manager will terminate instead of starting the user interface. Use **noStart** in combination with **import** if you want to import settings without starting X Manager. If **noStart** is specified, all other command line options except **import** are ignored.

- **-noMigrate**
  Affects initial startup actions as follows:
  - Disables automatic import of the “Sample Definitions” on page 25 in the template **generic_templates.rxd**, and any added templates configured for automatic import on first run.
  - Disables migration of settings from legacy Reflection X and Exceed.
  - Disables display of the Import Migrated Settings and Templates dialog box.

- **-? or -help**
  Displays a summary of command line options.
Examples

The following example logs the user Joe into the domain called "AcmeServer" and runs the client called xterm. In this example, X Manager for Domains will run minimized.

```bash
rxmgrdomains -domain AcmeServer -user Joe -password "secret" -client xterm -minimize
```

The following examples show two ways to start multiple clients (and any sessions associated with these clients). You can include all the clients on the command line or use a saved launch group definition. Quotation marks are required around the client and launch group definition names in these examples because the names include spaces. In these examples the domain user and password are omitted, so the user will be prompted for login credentials.

```bash
rxmgrdomains -domain AcmeServer -client "Client 1" -client "Client 2" -client "Client 3"
-or-
rxmgrdomains -domain AcmeServer -launchGroup "Work Group"
```

The following example starts an XDMCP connection to "My Host" without using an existing definition and without showing the X Manager for Domains window. This example is configured to log onto the domain as user Joe, who will be prompted for a password. When the user logs out of the XDMCP session, the session will stop and X Manager for Domains will exit.

```bash
rxmgrdomains -domain AcmeServer -user Joe -xdmcp direct,Myhost,,Exit
```

The following example launches X Manager for Domains with limited functionality. The user can launch existing definitions, but not add or modify definitions:

```bash
rxmgrdomains -execOnly
```

Options

The command line options are all optional. Options are case-insensitive. Use quotation marks around paths and definition names that include spaces. If a domain name, user name, or password is not specified, the user is prompted to provide it.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-domain domain_name</td>
<td>The domain name. This is the name of the computer running the domain controller.</td>
</tr>
<tr>
<td>-user user_name</td>
<td>The name of a domain user.</td>
</tr>
<tr>
<td>-password password</td>
<td>The password for the specified domain user. Use quotation marks if the password includes special characters.</td>
</tr>
<tr>
<td>-client client_name</td>
<td>Specify a client definition to start. To start multiple clients, use multiple client parameters (or configure a launch group.)</td>
</tr>
<tr>
<td>-xdmcp xdmcp_definition</td>
<td>Start an XDMCP connection using an existing definition name.</td>
</tr>
<tr>
<td>-or-</td>
<td></td>
</tr>
</tbody>
</table>
### xdmcp direct|indirect|broadcast,[host_address],[timeout],[onLastClient]

Specify XDMCP connection information directly on the command line. Specify host address using a DNS name or IP address. If the host address is omitted, the user is prompted. Specify timeout in seconds; the default is 15. Valid values for onLastClient are **Nothing** (or N), **Reset** (or R), **Stop** (or S), or **Exit** (or E). The default is **Reset**.

Do not use spaces after the commas in this option, and include a comma as placeholder for any option you don't need to specify. For example:

```
-xdmcp direct,myhost,,E
```

### -launchGroup group_name

Launch all X clients and/or XDMCP connections in the specified launch group definition.

### -session session_name

Specify a session definition to start. To start multiple sessions, use multiple session parameters.

### -owner

This is only valid when preceded by a **client**, **xdmcp**, **launchGroup**, or **session** option. It specifies the name of the user who created the preceding definition. When it is **owner** is not specified, the owner is assumed to be the currently logged in domain user.

This option is used by X Manager for Domains in desktop shortcuts, and allows the shortcut to distinguish between a definition created by the domain logon user or an identically-named definition created by the administrator and made public. Users should never need to use this option.

### -minimize

Start in a minimized state. This option is ignored if it's not supported by the operating system. This option is ignored if **trayOnly** is also specified.

### -trayOnly

Start with a tray icon but without opening the X Manager window. Note: When a session is started with this option, you can use either the tray icon or the Start menu to open the X Manager window.

### -noUI

Start with an icon in the tray area and without allowing the user to open the X Manager window. With this option, the Open X Manager option is disabled from the tray icon; the Exit and Help Topics options remain available. Note: When a session is started with this option, it is not possible to open the X Manager window from the Start menu until the session is closed and you stop X Manager using the tray icon's Exit option.

### -execOnly

Start with the user interface restricted to a list of definitions (X Clients, XDMCP Connections, Launch Groups, Sessions) and the basic controls to start, stop, leave and join. Items that allow creating new definitions, deleting definitions, or accessing other features (such as keyboard maps and color maps) related to definitions are not available.
Use `rxmigrate` on Windows systems to migrate settings from legacy Reflection X versions (v. 13 or 14) or from Hummingbird Exceed products. As `rxmigrate` runs, it displays messages to the console. In addition a `migration.log` file is created in the `logs` folder (page 112) (typically `C:\Users\<user>\Documents\Micro Focus\Reflection\logs\migration.log`).

**NOTE:** Settings stored on your local system are migrated automatically the first time you run Reflection X Manager or Reflection X Manager for Domains. Even if you choose not to import the settings on first run, you can manually import the migrated settings later. Settings in a shared network location are not imported automatically. You can use `rxmigrate` to migrate these settings.

### To convert legacy Reflection X settings:

```
rxmigrate [-a] [-c client1.rxc ...] [-s server1.rxs ...] [-k known_hosts ...] -o output.rxd
```

### To convert Exceed settings:

```
rxmigrate -product Exceed [-a] [-c client1.xs ...] [-s session1.ses ...] [-xc server1.xcfg...] -o output.rxd
```

### Examples

The following command line shows the options used for a default migration of settings from Reflection X 14.0. It migrates all Reflection X client and server settings, and any known host keys used for Secure Shell connections. The output file is located in a migration folder in the Reflection X Advantage data folder.

```
rxmigrate -a -o "%userprofile%\Documents\Micro Focus\Reflection\Reflection X 14_0_1.rxd"
```

The following command converts all Reflection X client files (*.rxc) in the specified network share and saves them to the specified output file.

```
rxmigrate -c \sharedsettings\rxa\*.rxc -o "c:\migrated settings\RXsettings.rxd"
```

The following command migrates all Exceed settings and saves them to the specified output file:

```
rxmigrate -product Exceed -a -o c:\migrate\Exceedsettings.rxd
```
Options

Note: For options that specify filenames, wildcards are supported for file names but not for directory names.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-product</td>
<td>(Optional) Specifies the product to be migrated. Valid values are Reflection and Exceed. If this option is omitted, the utility performs Reflection migration.</td>
</tr>
<tr>
<td>-a</td>
<td>(Optional) Migrates all client and server settings found on the local machine. When no product is specified, this option converts all legacy Reflection X settings (including known hosts).</td>
</tr>
<tr>
<td>-c</td>
<td>(Optional) Migrates the client settings from the specified client files (for example, client1.rxc client2.rxc).</td>
</tr>
<tr>
<td>-s</td>
<td>(Optional) Migrates the server settings (Reflection X) or session settings (Exceed) from the specified server files (for example, server1.rxs server2.rxs).</td>
</tr>
<tr>
<td>-xc</td>
<td>(Optional) Migrates Exceed server settings from the specified server files.</td>
</tr>
<tr>
<td>-k</td>
<td>(Optional) Migrates the hosts found in specified files (for example, known_hosts). This option applies to Reflection migration only.</td>
</tr>
<tr>
<td>-o</td>
<td>(Required) Specifies the path and file name of the output file to create (for example, output.rxd). Use quotation marks if the path includes spaces.</td>
</tr>
<tr>
<td>-version</td>
<td>Displays Reflection X Advantage version information.</td>
</tr>
<tr>
<td>-? or -help</td>
<td>Displays a summary of command line options.</td>
</tr>
</tbody>
</table>

rxsconfig Command Line Utility - Domain Configuration

Use rxsconfig to:

- Add the local computer (the one from which you run this utility) as a node to a Reflection X Advantage domain.
- Remove the local computer from the domain.
- Place a domain in recovery mode.
- Display a list of configured Reflection X services processes.

General syntax

rxsconfig join | leave | recover | version | list

Use the following syntax to view the options available for each command:

rxsconfig <command> -help

Join

Adds the local computer as a node on the specified domain. (See options below.) The join syntax is:

```bash
rxsconfig join [-u user] [-p password] [-f] [-a alternate-address[,..]] domain [node-listening-address]
```
For example, to add the computer from which you are running `rxsconfig` to a Reflection X Advantage domain running on rxa.domain.com:

```
rxsconfig join rxa.domain.com
```

**Leave**

Removes the local computer from the domain. (See options below.) The `leave` syntax is:

```
rxsconfig leave [-u user] [-p password] [-f] domain [node-listening-address]
```

For example:

```
rxsconfig leave rxa.domain.com
```

**Recover**

Instructs the domain to enter recovery mode the next time the service starts. Use recovery mode if you are locked out of a domain because you forgot the administrator password, changed authentication methods without adding an administrative account, or experience a problem with the external authentication system. The `recover` syntax is:

```
rxsconfig recover [-f] [domain_listening_address]
```

For additional information about using the `recover` option, see “Unlock a Domain” on page 50.

**Version**

Displays Reflection X Advantage version information. The `version` syntax is:

```
rxsconfig version
```

**List**

Displays configured Reflection X Service processes (domain controllers, domain nodes, and remote session service nodes) sorted by port number. Each line contains the listening address and a brief description. The `list` syntax is:

```
rxsconfig list
```

---

**NOTE**

- You must have root/administrative privileges on the computer in order to use `rxsconfig`.
- On UNIX systems, the installer does not add `rxsconfig` to the path. Run it from the install directory, include complete path information, or add it to your path. On UNIX systems, the default location is `/opt/rxadvantage/rxsconfig`.
- For newer Windows systems (starting with Windows Vista and Windows Server 2008), you need to open the command window as an administrator. (In the Start menu, under Accessories, right-click Command Prompt and select Run As Administrator).

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-u user</code></td>
<td>(optional) Specifies a Reflection X Advantage domain administrator. You will be prompted for a user name if this parameter is not specified.</td>
</tr>
<tr>
<td><code>-p password</code></td>
<td>(optional) Specifies the Reflection X Advantage domain user's password. You will be prompted for a password if this parameter is not specified.</td>
</tr>
</tbody>
</table>
**Options** | **Description**
--- | ---
-f | (optional) Runs **rxsconfig** in non-interactive mode. In this mode, -u, -p and **domain** are required parameters. The default response is used for any unspecified options.
-a alternate-address | (optional) Defines a comma delimited list of one or more alternate addresses for the domain node. Use this option if the node you are configuring resides behind a firewall that uses Network Address Translation (NAT). For example:

```
alternate.company.com:1234, 10.10.0.2:5678
```

You can omit the port and specify only an IP address. In this case, the port from the primary listening address is used.

Note: You can also add or modify alternate addresses for a node from the X Administrative Console **Domain Composition** tab.

domain | (required for **join** or **leave**) The name of the Reflection X Advantage domain controller, such as rxa.company.com.
node-listening-address | (optional) For **join**, this specifies the local listening address to use for the domain node, for example, **0.0.0.0:22001**.

If you omit this option, **rxsconfig** automatically generates an address for you on **0.0.0.0** (all available IP addresses) using port **22001** (or this first available port after **22001** if this port is not available).

Specifying **0.0.0.0** binds the node service to all available IP addresses. To bind to a specific IP address, specify that IP address. For example, to bind to an external facing network card using IP address **10.10.44.22** and port **22006**:

```
rxsconfig join rxa.com 10.10.44.22:22006.
```

You can omit the IP address and specify only a port, as shown below. In this case **rxsconfig** defaults to **0.0.0.0**.

```
rxsconfig join rxa.com 22006
```

For **leave**, this option is only needed if you added multiple nodes for the local computer on the specified domain.

-help | Displays a summary of command line options. Used alone this option displays the command choices.

```
rxsconfig -help
```

To see syntax details include a command. For example:

```
rxsconfig join -help
```
Using PKI Services Manager with Reflection X Advantage

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge from the Reflection X Desktop and Reflection Pro Desktop download pages.

- Reflection PKI Services Manager is required for Secure Shell connections that use certificates for host authentication. (It is not required for user authentication with certificates.)
- Reflection PKI Services Manager is required if you configure connections using the Management and Security Server Administrative WebStation that use the Security Proxy. For these connections PKI Services Manager validates the Security Proxy's certificate.
- Reflection PKI Services Manager is supported on both Windows and UNIX platforms.
- Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Micro Focus products. (Because Reflection X Advantage settings allow only one entry for the PKI Services Manager address and port, this configuration creates a potential single point of failure. If PKI Services Manager is unreachable or the server is not running, all authentication attempts using certificates will fail. In order to provide load balancing and failover, you can define a round-robin DNS entry for the PKI Services Manager host name or place the PKI Services Manager host behind a load balancing server.)
- You can run Reflection PKI Services Manager on the same host as a Reflection X Advantage domain controller or on a different host.

This user guide provides basic information about installing PKI Services Manager and configuring Reflection X Advantage to use it for certificate validation services. For additional information, refer to the PKI Services Manager documentation at http://support.attachmate.com/manuals/pki.html (http://support.attachmate.com/manuals/pki.html).

How it Works

1. The X client host presents a certificate to Reflection X Advantage for host authentication.
2. Reflection X Advantage connects to Reflection PKI Services Manager and verifies its identity using an installed public key.
3. Reflection X Advantage sends the certificate and host name to PKI Services Manager.
4. PKI Services Manager determines if the certificate is valid and uses mapping rules to determine whether the host is allowed to authenticate with this certificate.
5. If the certificate is valid and the host presenting it is an allowed identity for this certificate, Reflection X Advantage validates the host's digital signature. If the digital signature is verified, host authentication is successful.

In this Section

- “Setting up PKI Services Manager on Windows” on page 103
Setting up PKI Services Manager on Windows

In this Section

- “Install and Uninstall PKI Services Manager on Windows” on page 103
- “Configure PKI Services Manager on Windows” on page 104
- “Start and Stop the PKI Services Manager Service on Windows” on page 105

Install and Uninstall PKI Services Manager on Windows

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge from the Reflection X Desktop and Reflection Pro Desktop download pages. Use this procedure to install Reflection PKI Services Manager on Windows systems.

**NOTE:** Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Micro Focus products.

To install Reflection PKI Services Manager

1. Log in as an administrator.
2. Start the Setup program (**Setup.exe**). If you are installing from the download site, the following steps start this program:
   
   2a. From the download site, click the Windows download link and run the download program.
   
   2b. Select a location for the installer files, and then click Next. This extracts the files to the specified location and starts the Setup program.
3. Accept the default settings on the Advanced tab. (Creating an administrative installation image does not actually install the product — instead, it places the install files on a network location for later installation to multiple workstations.)
4. Start the service (page 105).

**NOTE**

- On Windows, starting the console or the service for the first time initializes PKI Services Manager. This creates the required data folders and default settings files. If these folders already exist, they are not changed; PKI Services Manager uses your existing data files and folders. (On UNIX the install script automatically initializes PKI Services Manager if required, and starts the service.)

- Before Reflection PKI Services Manager can validate certificates you need to edit the default configuration and map files.

To uninstall Reflection PKI Services Manager

1. Log in as an administrator.
2 From the Windows Programs and Features (or the Add or Remove Programs) control panel, select Micro Focus Reflection PKI Services Manager.

3 Click Uninstall (or Remove).

Configure PKI Services Manager on Windows

To configure client host authentication using certificates, you need to install and configure Reflection PKI Services Manager. Use the following procedure to get started. Many variations are possible. For more information about each of the steps below, see the Reflection PKI Services Manager User Guide, which is available from the PKI Services Manager console, and from http://support.attachmate.com/manuals/pki.html (http://support.attachmate.com/manuals/pki.html).

Before you begin

- Install PKI Services Manager (page 103).
- Determine which trusted CA certificate and intermediate certificates are needed to validate the certificate that will be presented by the host you are connecting to. PKI Services Manager can use certificate files that you copy to your system, or trusted root certificates installed to the Windows certificate store for use by the local computer.
- Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

To configure PKI Services Manager

1 Log in as an administrator on the computer running PKI Services Manager.

2 Start the PKI Services Manager console:

   Programs > Attachmate Reflection > Utilities > PKI Services Manager

3 Put a copy of the certificate (or certificates) you want to designate as a trust anchor into your certificate store. For example:

   C:\ProgramData\Attachmate\ReflectionPKI\local-store

   (This step is not required if you are using certificates in the Windows store or you have a copy of the trust anchor available somewhere else on your system.)

4 From the Trusted Chain pane, add your trust anchor (or anchors) to the list of trust anchors.
5 From the Revocation pane, configure certificate revocation checking.

NOTE: By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

6 From the Identity Mapper pane, click Add to determine which client hosts can authenticate with a valid certificate.

For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate’s Subject field:

- Set Select type of certificate that is to be mapped to Host Certificate
- Click the drop-down arrow for Choose certificate identity to insert and select Subject Common Name.

Refer to the PKI Services Manager documentation for additional information about mapping rules.

7 Click File > Save.

8 Start the PKI Services Manager service (page 105) if it isn't already running. If the service is already running, reload your settings (Server > Reload).

Start and Stop the PKI Services Manager Service on Windows

NOTE: The PKI Services Manager service starts automatically when you restart Windows.

To start the service

- From the PKI Services Manager console, click Server > Start.
- or-

- From a DOS command window, enter the following command:

  `winpki start`
-or-
  • Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Start.

To stop the service
  • From the PKI Services Manager console, click Server > Stop.
    -or-
  • From a DOS command window, enter the following command:
    winpki stop
    -or-
  • Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Stop.

To check the service status
  • Start the PKI Services Manager console and look for status information on the status line at the bottom of the console window.
    -or-
  • From a DOS command window, enter the following command:
    winpki ping
    -or-
  • Open the Windows Services console (Control Panel > Administrative Tools > Services) and view the status of Attachmate Reflection PKI Services Manager.

Setting up PKI Services Manager on UNIX

Use this information to install, uninstall, and configure PKI Services Manager on UNIX.

In this Section
  • "Install and Uninstall Reflection PKI Services Manager on UNIX" on page 106
  • "Configure PKI Services Manager on UNIX" on page 107
  • "Start and Stop the Service on UNIX" on page 109

Install and Uninstall Reflection PKI Services Manager on UNIX

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge from the Reflection X Desktop and Reflection Pro Desktop download pages. Use this procedure to install Reflection PKI Services Manager on UNIX systems.

To install Reflection PKI Services Manager
  1. Log in as root.
  2. Copy the installation package file to your computer and navigate to the directory that contains this file.
3 Use gzip to unzip the package:
   gzip -d package_name.tar.gz

   For example:
   gzip -d pkid_1.3.0.999-i386-solaris.gz

4 Use tar to expand the file:
   tar -xf package_name.tar

   This creates a directory based on the package name. For example:
   pkid_1.3.0.999--i386-solaris/

5 Change to this directory. For example:
   cd pkid_1.3.0.999-i386-solaris

6 Run the install script:
   ./install.sh

7 You are prompted to specify installation locations. To accept the default locations
   (recommended), press Enter in response to these prompts.

   **NOTE**
   - On UNIX the install script automatically starts the service.
   - Before Reflection PKI Services Manager can validate certificates you need to edit the
     default configuration and map files.

To uninstall

1 Log in as root.
2 Run the uninstall script. This script is installed to the bin directory in the PKI Services Manager
   data folder. The default path is:
   /opt/attachmate/pkid/bin/uninstall.sh

   **NOTE:** The uninstall script renames your existing configuration directory (/opt/attachmate/pkid/
   config/ by default) using a name based on the current date, and time. For example, config.20140101143755.
   Your local-store directory and any certificates you have added to this directory remain unchanged.

Configure PKI Services Manager on UNIX

To configure client host authentication using certificates, you need to install and configure Reflection
PKI Services Manager. Use the following procedure to get started. Many variations are possible. For
more information about each of the steps below, see the Reflection PKI Services Manager User
Guide, which is available from the PKI Services Manager console, and from http://

Before you begin
   - Install PKI Services Manager (page 106).
Obtain the trusted CA certificate and any intermediate certificates that are needed to validate the certificate that will be presented by the host you are connecting to.

Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

To configure PKI Services Manager

1. Log in as root on the Reflection PKI Services Manager server.
2. Install Reflection PKI Services Manager.
3. Put a copy of the certificate (or certificates) you want to designate as a trust anchor into your certificate store. The default PKI Services Manager store is in the following location:
   `/opt/attachmate/pkid/local-store`
4. Open the PKI Services Manager configuration file in a text editor. The default name and location is:
   `/opt/attachmate/pkid/config/pki_config`
5. Use the `TrustAnchor` keyword to identify your trust anchor. For example:

   ```
   TrustAnchor = trustedca.crt
   -or-
   TrustAnchor = CN=SecureCA,O=Acme,C=US
   ```

   **NOTE:** To configure multiple trust anchors, add additional `TrustAnchor` lines.

6. Configure certificate revocation checking. For example:

   ```
   To Sample Configuration
   ```
   Use CRLs stored on an LDAP server.
   ```
   RevocationCheckOrder = crlserver CRLServers=ldap://crlserver
   ```
   Use an OCSP responder.
   ```
   RevocationCheckOrder = ocsp OCSPResponders = http://ocspresponder
   ```

   **NOTE:** By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

1. If intermediate certificates are required by the chain of trust in your certificates, configure access to these certificates. For example:

   ```
   To Sample Configuration
   ```
   Use intermediate certificates you have added to your local store.
   ```
   CertSearchOrder=local
   ```
   Use certificates stored on an LDAP server.
   ```
   CertSearchOrder=certserver CertServers=ldap://ldapserver
   ```

2. Save your changes to the configuration file.
3. Open the PKI Services Manager map file in a text editor. The default name and location is:
   `/opt/attachmate/pkid/config/pki_mapfile`
4 Add one or more rules to determine which client hosts can authenticate with a valid certificate. For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate’s Subject field:

   RuleType = host
   {acme.com}

5 Test for valid PKI Services Manager configuration:

   /usr/local/sbin/pkid -k

   No errors. Configuration is valid:

6 Restart Reflection PKI Services Manager.

   /usr/local/sbin/pkid restart

Start and Stop the Service on UNIX

The PKI Services Manager service starts automatically after installation. A script is installed, which you can use to start, stop, restart, and check the status of the service.

The following procedures use the installed \texttt{pkid} script. For additional options available using the \texttt{pkid} daemon, see PKI Services Manager Command Reference or refer to the man page: \texttt{man pkid}

To start the service

   - On Linux and Solaris: \texttt{/etc/init.d/pkid start}
   - On AIX: \texttt{/etc/rc.d/init.d/pkid start}

To stop the service

   - On Linux and Solaris: \texttt{/etc/init.d/pkid stop}
   - On AIX: \texttt{/etc/rc.d/init.d/pkid stop}

To check the service status

   - On Linux and Solaris: \texttt{/etc/init.d/pkid status}
   - On AIX: \texttt{/etc/rc.d/init.d/pkid status}

Configure Reflection X Advantage to Connect to PKI Services Manager

Reflection X Advantage needs to connect to Reflection PKI Services Manager for host certificate verification. The procedure for configuring this connection depends on whether you are running in standalone or domain mode.

   - In standalone mode, use X Manager to configure the connection to PKI Services Manager. This connection must be configured individually on each computer running X Manager.

   - In domain mode, you need to use the Administrative Console to configure the connection to PKI Services Manager. This enables you to configure the connection once for all domain users. The connection information is used for all Secure Shell client connections in the domain that require host certificate authentication.
Before you begin

- Install PKI Services Manager (page 106).
- Configure PKI Services Manager. See “Configure PKI Services Manager on Windows” on page 104 or “Configure PKI Services Manager on UNIX” on page 107.

To configure X Manager to connect to PKI Services Manager

1. Start X Manager.
2. From the Tools menu, click Secure Shell Host keys.
3. Click the PKI Configuration tab.
4. For PKI server, specify the host name or IP address of the computer running PKI Services Manager. (You can specify localhost if you're running X Manager and PKI Services Manager on the same computer.)

**NOTE:** If PKI Services Manager is configured to use a non-default port, include the port value using hostname:port syntax. For example acme.com:18081.

5. Click Download key. This retrieves the public key from the specified PKI server and displays a dialog box that allows you to confirm this identity. To compare the presented fingerprint with the actual PKI Services Manager key open the PKI Services Manager console on the PKI server, and go to Utility > View Public Key.

When you click Yes to accept the key, the key is imported into the Reflection X Advantage database.

To configure a X Manager for Domains to connect to PKI Services Manager

1. Start the Administrative Console.
2. Click the Domain Composition tab.
3. For PKI server, specify the host name or IP address of the computer running PKI Services Manager. (You can specify localhost if you're running the Reflection X Advantage domain controller and PKI Services Manager on the same computer.)

**NOTE:** If PKI Services Manager is configured to use a non-default port, include the port value using hostname:port syntax. For example acme.com:18081.

4. Click Download key. This retrieves the public key from the specified PKI server and displays a dialog box that allows you to confirm this identity. To compare the presented fingerprint with the actual PKI Services Manager key open the PKI Services Manager console on the PKI server, and go to Utility > View Public Key.

When you click Yes to accept the key, the key is imported into the Reflection X Advantage database.
Reflection X Advantage provides tools and tips to help you pinpoint problems you may encounter:

Information and Error Messages

- Information about long-running tasks and error messages is displayed in the Task Status area at the bottom of the X Manager and Administrative Console windows. For tasks related to unsuccessful client connections, click the Information ("i") icon pane to display the Start Client dialog box. Two tabs in this dialog box provide client information.

- For additional information, refer to Reflection X Advantage Technical Notes (http://support.attachmate.com/techdocs/index/RXA.html).

Common Problems

Review the help topics in this section for tips on addressing issues with connections (page 116), displays (page 115), performance (page 117), and “Port Conflicts” on page 117.

Logging

- Domain-related messages and messages generated by X Manager and the X Administrative Console are automatically captured in a log file (page 112).

Trace

If you still can't resolve a problem, you may need to “Create a Trace” on page 113 and send it to Technical Support (http://www.attachmate.com/Support/).

If you send a trace to customer support, include the basic information about the product version you are running from the About box (Help menu > About).

In this Chapter

- “Troubleshooting Tools” on page 112
- “Application Fails to Start” on page 114
- “Display Problems” on page 115
- “Connection Problems” on page 116
- “Performance Problems” on page 117
- “Port Conflicts” on page 117
- “Domain Logon Problems” on page 117
- “Domain Node is Unavailable” on page 118
- “IME Troubleshooting” on page 118
- “Key Mapping Problems” on page 119
Troubleshooting Tools

Use the Logging features and Trace Utility to narrow down the source of a problem in Reflection X Advantage.

- "Log Files" on page 112
- "Create a Trace" on page 113

Log Files

Messages related to the domain, and messages from X Manager and the Administrative Console are automatically logged. You can send additional information (for example font, keyboard, network activity, X protocol errors, and so on) to the log files on a per-session basis by enabling the options on the session definition Logging tab.

Reflection X log files are created for the following applications and services:

<table>
<thead>
<tr>
<th>Application</th>
<th>Log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Manager</td>
<td>xmanager.log</td>
</tr>
<tr>
<td>X Manager for Domains</td>
<td>xmanager.log</td>
</tr>
<tr>
<td>X Administrative Console</td>
<td>xadmin.log</td>
</tr>
<tr>
<td>rxsconfig</td>
<td>rxsconfig.log</td>
</tr>
<tr>
<td>rxmigrate</td>
<td>migration.log</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service</th>
<th>Log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflection X Service</td>
<td>rxs.log</td>
</tr>
<tr>
<td>Domain Controller (process of Reflection X Service)</td>
<td>domain.log</td>
</tr>
<tr>
<td>Domain Node (process of Reflection X Service)</td>
<td>node.log</td>
</tr>
<tr>
<td>Remote Session Services (process of Reflection X Service)</td>
<td>node.log</td>
</tr>
</tbody>
</table>

The locations of these log files vary by platform:

Windows

**Application log files:**

%USERPROFILE%\Documents\Micro Focus\Reflection\logs

**Service log files:**

%ALLUSERSPROFILE%\attachmate\rx\logs
Create a Trace

While troubleshooting a problem, Micro Focus Technical Support may request that you obtain one or more traces of program actions. After receiving your trace file, Technical Support can replay the trace to replicate the problem.

To create a trace file

1. Under X Clients or XDMCP Connections, select the client you want to troubleshoot. Note the name of the Default session used by this definition. You'll modify this session to create the trace.

2. Under Session Definitions, select the session. On the Advanced tab, select Trace session.


4. The Trace Session dialog box opens and you can use it to specify an output filename and location.

   If the session will run on the local machine, you see full path information. You can save the trace to the default location shown, or browse to select an alternate location.

   If the session will run on a remote node, the trace file will be saved to that remote system and you see only a filename. (This occurs when Remote Session Services on the session definition's General tab is set to anything other than None.) When no path information is given, the trace file is saved to the Reflection X Advantage program location (typically C:\Program Files\Micro Focus\Reflection on Windows and /opt/rxadvantage on UNIX). You can add path information relative to this location, or specify full path information. In either case, the path specified must be valid and accessible on the remote system.

5. Click Trace session to continue your connection and start recording.

   The trace is saved to the location you specified when the session stops.

UNIX

Application log files:
~/.microfocus/reflection/logs

Service log files:
rxs.log (service launcher)
/var/log
rxs.log (log file for the service itself), domain.log, node.log, rxsconfig.log
/opt/rxadvantage/logs

HP-UX

Application log files:
~/.microfocus/reflection/logs

Service log files:
rxs.log (service launcher)
/var/adm
rxs.log (log file for the service itself), domain.log, node.log, rxsconfig.log
/opt/rxadvantage/logs
6 Return to Advanced tab for your session definition and clear the Trace session checkbox.

7 Upload the trace file as a binary file to http://upload.attachmate.com. If the problem relates to a service request you are currently working on with a technician, include the service request number with the trace and let the technician know when the file is uploaded.

Application Fails to Start

These problems may prevent Reflection X Advantage applications from launching:

- No Java Runtime Environment (JRE) was found
- Database may be in inconsistent state (page 114)
- Insufficient Memory (page 115)

No Java Runtime Environment (JRE) was found

Reflection X Advantage applications require a JRE on your system. On Windows systems, the JRE is included as a separate feature in the installation -- called Java Runtime Environment (JRE). If this feature has not been installed and no additional JRE is available on your system, you see a message saying that the application "failed to start because no Java Runtime Environment was found." To resolve this, install the JRE using the procedure below.

If the JRE feature is not installed and an alternate JRE is found on your system, Reflection X Advantage will start using the alternate JRE, but you will see errors or warning messages in the log files if this JRE is not correctly configured. For information about these messages, see “Changing the JRE” on page 90.

To install the default JRE

1 To open the Programs and Features control panel go to Start > Control Panel > Programs and Features. (On older Windows systems, this Control Panel is called Add or Remove Programs.)

2 Select your Reflection product and click Change.

3 On the Feature Selection tab, click the icon to the left of Java Runtime Environment (JRE) and select Feature will be installed on local hard drive.

4 Click Continue.

Database may be in inconsistent state

Reflection X Advantage applications store data in a database file (flatfiledb-data.xml). During some operations a backup file (flatfiledb-data.xml.bak) is created temporarily. If the backup file is still present in the database folder when you start X Manager, X Manager, or X Administrative Console, you may see a message saying that the "Database may be in inconsistent state" and the application will not start.

To restore the database when a .bak file is present

1 Navigate to the database file location displayed in the error message and locate flatfiledb-data.xml and flatfiledb-data.xml.bak.

2 Create a backup copy of both files in a secure location.

3 Check the dates and sizes of both files.
4 If one file is larger, delete the smaller file and try to start the application. If starting with the larger file doesn't work, replace it with the larger file from the backup location.

5 If the files are the same size, delete the older file and try to start the application. If starting with the newer file doesn't work, replace it with the older file from the backup location.

**Insufficient Memory**

When Reflection X Advantage applications start, they request a block of memory from the computer system. If your system’s memory is limited or fragmented, you may see an error saying “Application failed to start due to insufficient memory.” This is more likely to occur if you have installed the 32-bit version of Reflection X Advantage. If you are running on a 64-bit system and have access to the 64-bit installer, you should install that version. If you are on a 32-bit system, restarting Windows may resolve the problem. If you continue to see this message, you may be able to resolve it by reducing the maximum memory available to the Reflection X Advantage JVM. For details, see Technical Note 2657 (http://support.attachmate.com/techdocs/2657.html).

**Display Problems**

Use the following topic to troubleshoot color- and display-related problems:

**Scattered Desktop Display**

When configuring a desktop session using an X client command (for example gnome-session, startkde, or Xsession), your desktop elements appear scattered on your Windows desktop. This can be the result of your session settings. Change your session definition to use one of the following options:

- **Show clients on X terminal desktop**

**Color Allocation**

You may see one of the following errors if an X client makes an unsuccessful color request, typically because the client wants to create a new color and cannot:

- **X Error of failed request: BadAlloc**
  - Major opcode of failed request: 84 (XAllocColor)

- **X Error of failed request: BadAlloc**
  - Major opcode of failed request: 86 (XAllocColorCells)

- **X Error of failed request: BadAlloc**
  - Major opcode of failed request: 87 (XAllocColorPlanes)

To resolve color allocation errors:

- Change the Default Visual Type setting in the session Display tab from a static color model (TrueColor, 24-bit depth) to a dynamic color model (PseudoColor, 8-bit depth).

**OpenGL Applications**

Many OpenGL applications require a TrueColor visual. On the session Display tab, check the Default Visual Type. If this is set to PseudoColor, 8-bit depth, you'll see colors flashing when 3D graphics are displayed. Configure the session to use a higher color depth to eliminate the flashing. Select either <Best Visual> or TrueColor, 24-bit depth.

**TrueColor**

If the X client application you are running expects a default visual type that allows the colormap to be changed, you cannot use TrueColor, 24-bit depth as the Default Visual Type. Doing so may prevent the client from starting, and result in an error message.
For example, attempting to run the ico2 client using the following command:

```
ico2 -faces -dbl -colors gray blue yellow
```

...results in an error message, as follows:

"Server can't support dynamic colormaps"

-or-

"BadMatch (invalid parameter attribute)"

If you attempt to run the X client `xfishtank` with **TrueColor, 24-bit depth** selected as the Default Visual Type, the following error message appears:

"Don't know how to format image for display of depth 24"

Some clients do not return an error message. Instead, gray, hatched patterns are displayed in place of the correct colors.

If you are running an X client that exhibits any of these problems, select **PseudoColor, 8-bit depth** as the Default Visual Type.

**NOTE:** A Default Visual Type setting of `<Best Visual>` often results in a setting of **TrueColor, 24-bit depth**.

---

**Connection Problems**

If you are having difficulty connecting to an X client or an XDMCP desktop, review the following tips:

- If you are trying to connect to an X client and see "Client failed to connect to the X server" in the Status bar, the specified Command may not be valid on your host. Try changing the Host type and use the command drop-down list to test with a different sample command. For additional information, click the Information icon 1 to open the Start Client log. Review the log for terminal and X Manager activity messages.
- You may need to configure your firewall for the ports being used by Reflection X Advantage. See “Ports used by Reflection X Advantage” on page 85 for a summary of these ports.
- If you are connecting through a VPN and are having problems using XDMCP to connect to a session, you may be able to resolve the problem by using a distributed session. With this configuration, the client connector that originates the XDMCP request runs on the X application host and the request does not have to travel through the VPN router. (VPN routers typically block XDMCP connection requests.) If you’re using X Manager, see “How to Configure a Distributed Session in Standalone Mode” on page 35. If you’re using X Manager for Domains, see “Domain Setup: Improve Performance Over a Slow Network” on page 51.
- If your host name resolves to an IPv6 address, try specifying an IPv4 address for the host instead of using the host name.
- If you are having trouble establishing an XDMCP connection, try starting a desktop session without using XDMCP.
- If you have configured X Manager to use remote session services (page 35), the connection to the remote UNIX host uses PAM authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log on using root credentials.
Performance Problems

If you're experiencing performance problems with Reflection X Advantage, try the following:

- Review the Session Statistics of a running session to determine if low bandwidth or high latency is a problem in your network. For information about using remote session services to improve performance with X Manager (standalone), see “How to Configure a Distributed Session in Standalone Mode” on page 35. If you're running X Manager for Domains, see “Domain Setup: Improve Performance Over a Slow Network” on page 51.

- On the session definition Display tab, set **Backing store** to **When mapped with save unders**. This will reduce network traffic from X clients.

- Monitor sessions from the **Domain Status** tab on the X Administrative Console to find the source of the problem.

- If you are running in domain mode, configure load balancing to set the load balancing scheme and to ensure that the load is properly balanced among the domain nodes.

Port Conflicts

TCP port 6000 is the standard X11 listening port. Both Reflection X Advantage and Reflection X version 14.0 listen on port 6000 by default. If you are running both products, each product should listen on a different port.

Reflection X Advantage will choose an available port unless **Require display number** (Session Definition > Advanced) is set. To use a specific display number, set the **Require display number** option.

Related Topics

- “Ports used by Reflection X Advantage” on page 85

Domain Logon Problems

If you are having trouble logging into a domain from X Manager for Domains or X Administrative Console, check the following:

- Check to see if you entered the correct Reflection X Advantage domain name (not your Windows domain) in the **Enter Logon Information** dialog box. The Reflection X Advantage domain name is always the name of the computer running the Reflection X Advantage domain controller. Get this information from the Reflection X Advantage domain administrator.

- Ensure that the version of X Manager for Domains running on your workstation is the same or newer than the version running on the domain controller.

- Ensure that the domain controller service is running and that the host is available on your network.

- If you upgraded from a version earlier than 5.0 and run in FIPS mode, the certificates used to authenticate domain components need to be upgraded. See “Upgrade Digital Certificates used by Reflection X Advantage Domains” on page 93.
If you are having trouble logging into a domain from the X Administrative Console, check the following:

- You can be locked out of a domain if you forget the administrator password, change authentication methods without adding an administrative account, or experience a problem with the external authentication system. You can unlock the domain without losing your configuration data by using the `rxsconfig` utility. For details, see "Unlock a Domain" on page 50.
- If you are running on a UNIX system and cannot log in as root, log in using a different account name. On some UNIX systems, the `pam_securetty` module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X Advantage domain using root credentials.

**Domain Node is Unavailable**

If a registered domain node appears with a red slash in the X Administrative Console, the node is unavailable. This could be caused by any of the following:

- The domain node host is not running.
- The domain node is running on a Windows computer in "sleep" mode.
- The network connection to the domain node is down.
- The domain node and domain controller are not running the same version of Reflection X Advantage.
- The node was removed from the domain using `rxsconfig`, but the utility was unable to reach the domain controller to update the list of registered nodes.
- The domain node is running on a system with insufficient memory. See Technical Note 2657 (http://support.attachmate.com/techdocs/2657.html).

**IME Troubleshooting**

Review this information if you've configured Reflection X Advantage to use your local Input Method Editor (IME) and you're still unable to use your IME to enter text into the X client. For additional information, see Technical Note 2504 (http://support.attachmate.com/techdocs/2504.html).

**Logging XIM activity**

Enable XIM logging and review the output log to determine if your X client is XIM-aware and to see if it is configured to use the Reflection X Advantage IME server.

**To log XIM activity**

1. Under **Session Definitions**, select the session you have configured to use native IME support.
2. In the **Session Definition** pane, expand **Logging**, then select **Log XIM activity**.
3. Start your client and attempt to use the local input editor.
4. Review the log information in the appropriate log file (page 112).

**Platform-specific steps for configuring hosts to support use of your local IME**

Use the following platform-specific steps to configure X clients to use the X input method (XIM), which is a requirement for configuring Reflection X Advantage to use your local IME.
**Red Hat 5**

The Red Hat 5 desktop is configured to use SCIM (Smart Common Input Method), and all GTK (GNOME Toolkit) applications use SCIM by default. To be able to use your local IME with these clients, you need to configure them to use the X Input method (XIM). You can configure clients to use XIM by using a context menu that allows you to change the input method, however the context menu is not available by default. Use the following procedure to enable and use this context menu.

**To enable the context menu and configure a client to use the XIM server**

1. Start your session
2. Execute the following command to enable the context menu.
   ```bash
gconftool-2 --type bool --set '/desktop/gnome/interface/show_input_method_menu' true
   ```
   **NOTE:** You need to execute this command only once for each user of the system; doing this will make the context menu available for subsequent sessions.

3. Right-click in the client window.
4. Select X input method from the context menu.

**HP CDE**

Select a supported language before you log on to your XDMCP session. Supported languages are: ja_JP.UTF-8, ja_JP.EUC-JP, ja_JP, C, en_US.UTF-8, ko_KR.UTF-8, ko_KR

**Key Mapping Problems**

**Pressing Backspace doesn't produce expected behavior**

The recommended way to modify the behavior of the Backspace key is to configure the **Backspace sends** setting on the **Keyboard** tab for each session definition. (Note that this change is saved to your session definition, not to a keyboard map.) If you also apply a custom keyboard map to your session definition, do not change the mapping of the Backspace key in that map, as any changes you make in your custom map may override your **Backspace sends** setting preference.

**Functionality in the Keyboard Maps dialog box is disabled**

The default keyboard map is not editable. In the **Keyboard Maps** dialog box, Click **Clone** to create a new editable keyboard map, or use **Select Keyboard Map** to select a keyboard map that you have already created.

**Custom Keyboard Map settings are not taking effect**

Select the session definition used by your client, and click the **Keyboard** tab. Check to see if **Keyboard Map** is set to use your modified keyboard map.
bandwidth. The rate of transmission of data across the network; the maximum amount of information (Kbits/second or Mbits/second) that can be transmitted along a channel.

cipher. A cipher is an encryption algorithm. The cipher you select determines which mathematical algorithm is used to obscure the data being sent after a successful Secure Shell connection has been established.

client connector. Accepts incoming connection requests from X clients and forwards X protocol requests received from the X client to the protocol router. The client connector also receives X protocol replies, events, and errors from the protocol router and forwards these to the appropriate X client.

color scheme. Color schemes translate string color names requested by clients into RGB (red, green, blue) values.

compressor. Compresses X protocol messages, sends them across the network, decompresses them, and forwards them.

client definition. Contains configuration information for starting one or more X client applications on a host.

controlling X server. The X server in a session that has control of keyboard and mouse input.

definition. A set of related settings used to configure some aspect of a session. Definitions are stored locally or in a domain. Definition types include X Clients, XDMCP Connections, Launch Groups, and Session Definitions.

definition file. Definition files (*.rxd) contain Reflection X Advantage configuration information in XML format. This file format is used to export and import settings to and from Reflection X Advantage.

distributed X session. An X session whose session components are running on more than one computer.

domain. A Reflection X Advantage domain consists of one or more computers on which X session components are run and load-balanced. The domain also defines a group of users who can run and share X sessions on those computers.

domain controller. This term applies to the computer that runs the domain controller software component, and is responsible for authenticating users, starting and stopping session components on domain nodes, and centralized storage of settings.

domain node. A computer on which Reflection X Advantage is installed that an administrator has included in a Reflection X Advantage domain.

font collection. A set of font files or a reference to a font server. Font collections can be either private or public.

headless X server. A special type of X server that has no display. It maintains display contents in memory and serves to keep a session "alive" when no other X servers are connected. It can also provide short-circuiting of certain X protocol requests.

IME (Input Method Editor). An input method editor is an application that allows you to enter characters and symbols that are not available on your keyboard.
internal authentication. A proprietary authentication system that can be used by Reflection X Advantage to grant users access to domain features. If the domain is configured to use internal authentication, Reflection X Advantage maintains an internal database of the user names/passwords that are authorized by the system.

JVM. Java Virtual Machine. A virtual machine that interprets and executes Java bytecode. Because Reflection X Advantage is a Java application, a JVM must exist on every machine that runs Reflection X Advantage.

keycode. In the X Window System, every individual, physical key is associated with a number in the range 8–255, called its keycode. A keycode only identifies a key, not a particular character or term among the ones that may be printed on the key. (See X keysym.)

keysym. See X keysym.

latency. The time delay between when an action is initiated and when its effect is detectable. In a network, a delay in the reception of data packets can be caused by several factors, such as the transmission medium, and the number of network devices between the sending and receiving points. In general, the greater the physical distance between your workstation and your host, the greater the chance of encountering latency.

passphrase. A passphrase is similar to a password, except it can be a phrase with a series of words, punctuation, numbers, white space, or any string of characters. Passphrases improve security by limiting access to secure objects, such as private keys and/or a key agent.

PKCS. PKCS (Public Key Cryptography Standards) is a set of standards devised and published by RSA laboratories that enable compatibility among public key cryptography implementations. Different PKCS standards identify specifications for particular cryptographic uses. Reflection X Advantage uses the following PKCS standards:

PKCS#5 is used to provide password-based encryption for private keys stored in the Reflection X Advantage database.

PKCS#11 provides support for authentication using hardware devices, such as smart cards or USB tokens.

PKCS#12 is used for storage and transportation of certificates and associated private keys. Files in this format typically use a *.pfx or *.p12 extension.

private definition. Configuration settings (for an X Client, XDMCP connection, launch group, or session) that can only be viewed and used by the user who created it. A private definition is read-write for the user who created it.

protocol router. Receives X protocol requests from client connectors and forwards them to all of the X servers in the session. It synchronizes the processing of requests and device events to ensure that all the X servers in the session remain in identical states.

public definition. Configuration settings (for an X Client, XDMCP connection, launch group, or session) that an administrator has made available to users in a Reflection X Advantage domain. A public definition is read-write for the administrator and read-only for all other users.

Reflection X Service. A service (or daemon) on a computer that can be configured as a domain controller, domain node, and/or support remote session services. (The services supported depend on which features you installed (page 14).)

remote session. In a remote session, the Reflection X Advantage session processes (the client connector and protocol router) run on a different computer than X Manager or X Manager for Domains.
**session.** A running session consists of several running components (client connectors, a protocol router, and X servers) whose configuration is determined by the session definition. A running session may or may not have X client applications connected to it, but a session must be running before a client application can be displayed. You can associate a default session definition with each of your X client applications, or configure these definitions to prompt you for a session name when you start the client. If the associated session is not already running, Reflection X Advantage starts the session when you start the client.

**session definition.** A combination of settings that affect how Reflection X Advantage manages and displays your connections. You can associate a default session definition with each of your X clients (including XDMCP connections), or configure these definitions to prompt you for a session name when you start the client. If the associated session is not already running, Reflection X Advantage starts the session when you start the client.

**standalone X session.** An X session whose components are running on a single computer.

**suspended X session.** A running X session that does not have an X server display currently associated with it. When a user leaves a session, its display state is maintained in memory on a member node within the domain.

**X Administrative Console.** X Administrative Console is a management tool for configuring and managing Reflection X Advantage domains. You can use it to control user access to a domain; share client and session definitions; configure load balancing; and monitor sessions.

**X Keysym.** An X Keysym is an encoding of a symbol on the cap of a key. The set of defined X Keysyms includes the ISO Latin character sets, Katakana, Arabic, Cyrillic, Greek, Technical, Publishing, APL, Hebrew, Thai, Korean, and other keys found on keyboards such as Return, Help, and Tab.

A list of X Keysyms is associated with each keycode. The list is intended to convey the set of symbols on the corresponding key. Standard rules for obtaining an X Keysym from a KeyPress event make use of only the first four X Keysyms associated with a keycode. Depending on the state of the Shift and ModeSwitch (AltGr) modifiers, one of the first four keysyms will be selected.

**X Manager.** A Reflection X Advantage tool that allows you to configure and launch X sessions locally, and permits session sharing. It does not use a Reflection X domain; nor does it allow users to leave and rejoin sessions.

**X Manager for Domains.** An application that connects to a Reflection X domain storing session definitions in a database. X sessions run locally, or on domain nodes, which support fault tolerance and protocol compression. It permits session sharing, and allows users to leave and rejoin sessions.

**X server.** The session component that provides a visual display of your X client applications. The controlling X server also manages input devices, such as keyboard and mouse. Each running session includes at least one running X server.

**X server display.** An X server with a visual display or "viewer," as opposed to a headless X server, which has no display.

**XDMCP.** XDMCP (X Display Manager Control Protocol) supports display of a remote desktop on an X server. XDM (the X Window Display Manager) must be configured on the remote host.

**XIM server.** XIM (X Input Method) is an X11 protocol that supports composed character input. The XIM server provided by Reflection X Advantage can obtain composed text from an IME running on the Reflection X Advantage workstation and pass this text to XIM-aware X clients. (Reflection X Advantage does not support passing composed text to other input methods that may be provided by your operating system, such as XIMP and SCIM.)